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Supported Operating Systems and Browsers 
The tables below show the operating systems and browsers currently supported.  

NOTE: The list shown in the table below are operating systems we support, though they may not be 
actively tested. 

Platform OS Version  Browser Version 
Desktop  Internet Explorer 11 

Windows 7, 10  Microsoft Edge 
Mac 10.13.4 (High 

Sierra) 
 Google Chrome latest 

Mobile  Mozilla Firefox latest 
iOS 11.4.1 -> latest  Safari latest 
Android 6.0.1-> latest    
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General/New UI Dashboard 
New UI: Dashboard (Desktop & Mobile)  
In this release, we are redesigning and adding many great new features to the home Dashboard to align 
your experience with the New UI. Some of the changes will be within the New UI Dashboard Layout 
Profile, while others will be able to be done within the dashboard itself.  

New UI Dashboard Layout Profile/Configuration Changes (Desktop) 
The dashboard layout configuration is located under Company Settings > Profiles/Policies > New UI 
Dashboard Layout. 

Adjust Tile Layout in the New Dashboard Layout Configuration (Desktop) 
144061: Users with permissions to view/edit the New UI Dashboard Layout Profile can adjust 
the tile layout in the new dashboard layout configuration under Company Settings > 
Profiles/Policies > New UI Dashboard Layout > Edit.  

Users can adjust tile layout between two options: 

• Horizontal 
• Matrix 

Users can adjust the tile: 

• Width 
• Height 

The Dashboard allows for up to three tile spaces. 
  
NOTE: Open Full Screen and Close Full Screen are available options in the Mobile Application 
for end users on their dashboards. These are not available options in the configuration. 

Assign the New Dashboard Layout Profile to Employees (Desktop) 
147536: Users (Managers, Admins) with permissions to view employees and assign the New 
Dashboard Profile where the employee has the first screen set to the New Dashboard Profile 
can assign the New Dashboard Layout Profile to their employees. 
 
The New Dashboard Layout is shown to the employee when:  

• A user is assigned the New Dashboard Profile and was not previously assigned to one.  
• Multiple schedules exist within a profile and the schedule period is changing.  
• When a user is assigned the New Dashboard Profile and was previously assigned to another profile, the new 

dashboard layout is shown to employee on their next login (reset is not required). 
 

When changes are made to New Dashboard Profile for the current layout schedule, the employee 
dashboard remains as is. Administrators can create a new schedule to reset a user’s layout. 

If multiple schedules exist within a profile and the current layout is deleted, the previous Dashboard 
Layout is shown to the employee. The Custom tabs are removed. 
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Allow Employees/Managers to Modify the New Dashboard Layout Configuration (Desktop) 
144058: Admins can allow users to modify their New Dashboard Layout configuration when they have 
permissions to View/Edit the New UI Dashboard Layout Profile (Company Settings > Profiles/Policies > 
New UI Dashboard Layout). 

Configuration options are available to allow the admin to designate that the User Can Modify their 
dashboard. When enabled, the employee/manager has the following actions: 

• Edit Tabs option on the landing dashboard. 
• Add/Remove widgets and reports/charts. 
• Edit widget configuration. 
• The security/permissions remain the same. 

When the User Can Modify option is disabled, employees/managers do not have the following actions: 

• The Edit Tabs option on their landing dashboard (user sees what the admin has configured for them). 
• Add/Remove widgets and reports/charts. 
• Widget configuration is still allowed for widgets that require end user configuration. 
• Adjust the height/width is still allowed. 
• Filtering is still allowed. 
• Rearrange is still allowed. 

If a schedule period is changing and a previous schedule allowed users to modify but the new schedule 
does not, the Edit Tabs and Add/Remove options are no longer available to users when the schedule 
changes. Similarly, the same holds true if a profile is changed for employees and users could previously 
modify and no longer can.  
The User Can Modify option on the layout profile is dynamic and changes are reflected in real time. 

Update the New UI Dashboard Layout Assignment (Desktop) 
155130: Admins can update New UI Dashboard Layout assignments when they have the appropriate 
permissions to view employees and assign a New Dashboard Profile. Employees should have their first 
screen set to the New UI Dashboard (Home). 

Any assignment/re-assignment of a New UI Dashboard Layout Configuration profile applies a new 
Dashboard Layout to the user, and the new layout is applied according to its Effective Date. 

Save Dashboard Widget/Layout Configurations (Desktop) 
151042,156884: Users with permissions to view/edit the New UI Dashboard Layout Profile (Company 
Settings > Profiles/Policies > New UI Dashboard Layout > View/Edit New UI Dashboard Layout Profile, 
Edit in the Schedule widget) can choose to Save configurations such as:  

• The Screen Layout 
• Widgets that have been added, removed, configured, and/or re-ordered 
• Changes to the View mode (Report, Table), a selected Chart, and the Report settings 

The Save button is available on the Admin Configuration screen of the New Dashboard Layout as a page 
level action. If no changes have been made, the Save button is disabled.    

Reset Windows Widget Configurations to the Last Saved State (Desktop) 
145334,156966: Administrators can reset My Windows to the last saved state in the New Dashboard 
Layout Configurations when they have permissions to View/Edit the New UI Dashboard Layout Profiles 
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(Company Settings > Profiles/Policies > New UI Dashboard Layout, View/Edit New UI Dashboard Layout 
Profile, Edit in the Schedule widget). Selecting the Reset Windows option resets the entire 
configuration, including the widget configuration.  

 

The Reset Windows option is a page level action. A reset impacts the entire configuration including: 

• Rearranging existing tabs 
• Deletion of tabs 
• Adding/Removing/Re-Order of widgets, charts/reports, and pivot charts 

If a user makes changes and does not save, when selecting the Reset Windows button, a warning 
displays: Question (with the following text) Are you sure you want to reset your layout to its last saved 
state? 

• If the user chooses Cancel, the pop-up disappears and the reset is ignored. 
• If the user chooses Ok, the pop-up disappears and the reset is applied: 

– All tabs are reverted back to their last saved state, including configuration changes for tiles. 

If a user does not make changes, the Reset Windows button is disabled. 

Dashboard Security Items Moved to Dashboard Section in Security Profile (Desktop) 
160558: The Dashboard Security Items have been moved to the Dashboard section in Security Profiles. 
The following changes were made:  

• The Allowed Windows item is renamed to Allowed Widgets. 
• The location of the Allowed Widgets security section has been moved to Security Items > Dashboards. 
• The Dashboards section is available for all sub-systems. 
• A new section for Dashboard Widgets has been added. 
• The Allowed Widgets can be seen within Dashboard Widgets section.  
• The settings of custom selections from ESS > Allowed Windows to Dashboard > Allowed Widgets can be 

migrated so that clients do not need to manually set the enabled/disabled widgets. All security settings will 
remain as they were for users. 
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Charts/Tiles and Reports (Desktop) 

Show Chart Tile as Report on Dashboard Tile (Desktop) 
145450: Users can switch between Report and Chart views on a Dashboard tile when they have the 
appropriate permissions to View/Edit the Report and/or Chart tile(s). 

Users can toggle between the Report view and the Chart view and are able to view one Chart at a time. 
Users can toggle between more than one Chart if needed.  

The View mode is retained when a user switches the tile from the Chart view to the data/Report view 
and logs out. When the user logs back in, the view remains as data/report. Report filters are only 
retained if a report is saved. 

Users have tile level options in both the Chart view and the Report view to remove the tile and/or adjust 
the tile width.  
NOTE: The Save View As and Delete options (under Manage Views) are not currently available but are 
planned for a future release. Users can still save changes to select views and interact with the rest of the 
actions/information in the Manage Views popup. 

Print Charts from New UI Dashboard Layout (Desktop) 
152815: Administrators can now print information from a New UI Dashboard Layout.  
• Only charts can be printed from the new dashboard layout. The Charts preview mode is defined by 

the user via the Re-arrange Tiles side panel. 
• Two charts can be printed on the same sheet if Portrait orientation is selected when the A4 or 

Letter paper format is set up. 
• The number of charts on the Dashboard corresponds to the number of charts in the printed pages. 
• If a No Data to Display warning message is displayed on the chart tile, the chart will not be printed. 
• The chart name is displayed for each chart. 
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New UI Dashboard Widgets (Desktop) 

Add Widgets in the New Dashboard Layout Configuration (Desktop) 
144052: Admins can add widgets in the New Dashboard Layout configuration when they have 
permissions to View/Edit the New UI Dashboard Layout Profile (Company Settings > Profiles/Policies > 
New UI Dashboard Layout, Edit). 

 

Users can see the option to add tiles at the top of the layout configuration screen. If a tab already has 20 
tiles added, +Add is disabled. When hovering over the action, the following Tooltip displays: Max of 20 
tiles are allowed to be displayed per dashboard. 

When a user clicks on the Add button, a drop-down appears with a Widget option. When a user selects 
the Widget drop-down, the pop-up opens and the user can see a list of Available widgets and Current 
widgets. Users can select the appropriate checkbox(es) for the widget(s) they wish to add. A widget can 
only be added once, and if already selected, it appears in the list of Current widgets.  

A maximum of 20 combined total widgets are allowed and indicated on the panel. If 20 or less tiles are 
selected, an info message is displayed at the top of the panel that reads Max of 20 widgets-are allowed 
to be displayed per dashboard. If more than 20 tiles are selected, an error message displays at the top of 
the panel and reads: You have exceeded 20 tiles limit.  

Once a user selects the widget(s) to be added, the user clicks Add to move them from the Available 
widgets panel to the Current widgets panel.  

If a user saves on the Add Tiles screen, the tiles appear on the tab the user was on prior to clicking the 
Continue button. If a user cancels (or exits) the Add Tiles screen, changes are not saved and the tab 
layout appears as it did prior to clicking the Add button. 

If a user does not have permissions to see a widget that is added, the widget does not appear for the 
user. 

Add Widgets to My Landing Dashboard (Desktop) 
149181: End users can now add widgets to the My Landing Dashboard Layout when the new dashboard 
is in use. The user must have:  

• The new Dashboard Profile assigned (for the landing experience). 
• Permissions to modify the Dashboard Layout (for the landing experience). 
• Navigated to the Landing Dashboard. 
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Users can see the option to Add (+Add) tiles at top of the Layout Configuration screen. A maximum of 20 
combined total widgets are allowed. If a tab already has 20 widgets added, the +Add is disabled. If a 
user hovers over the action, a Tooltip explains that a Max of 20 tiles are allowed to be displayed per 
dashboard. 
 
When a user clicks on the +Add button, a drop-down displays with a Widget option. When the user 
selects the Widget drop-down, a pop-up opens and displays a list of available widgets and current 
widgets. Users can select the appropriate checkbox(es) for the widget(s) they want to add. A widget can 
only be added once, and it should appear in the list of current widgets if already selected.  
 
 If 20 or less tiles are selected, an informational message displays at the top of the panel that reads: Max 
of 20 widgets are allowed to be displayed per dashboard. If more than 20 tiles are selected, an error 
message displays at the top of the panel that reads: You have exceeded 20 tiles limit. 
 
If a user does not have permissions to see a widget that has been added, the widget does not appear for 
the user. Once a user selects widgets to be added, the user should click Add to move them from the 
Available Widgets panel to the Current Widgets panel.  
 
If a user saves on the Add tiles screen, the tiles appear on the tab the user was on prior to clicking the 
Continue button. If a user cancels (or exits) the Add tiles screen, the changes are not saved and the tab 
layout appears as it did prior to clicking the Add button. 

Perspectives Widget in Landing Page/New UI Dashboard (Desktop) 
152116,156878: The Team Perspectives widget has been migrated to the New UI Dashboard. Users can 
utilize the +Add button to add the Perspectives widget to the landing page.  
 

 
 
Users can select the Configure Tile button to display the Perspectives widget side panel so they can 
configure the widget. The user selects the appropriate filter(s), clicks the Apply button, and the 
Perspectives widget is displayed.  
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The top ellipses include the following actions: 

• Remove 
• Adjust Tile Width 
• Adjust Tile Height 

If the Team Perspectives tile has been added, but has not yet been configured, the Configure button is 
displayed. Once clicked, the filter panel opens, allowing users to select employees and dates. Once the 
tile has been configured, the filter icon displays with the number of filters applied and filter descriptions 
(read only).  
 

 
Clicking on the Perspective title redirects the user to the Perspective Score report. Clicking on the 
Perspective label redirects users to the Perspective Score report with the perspective filtered and the 
period applied. 

NOTE: Widgets that were previously configured will be migrated to the new format, and the 
configurations will remain the same. 

Accrual Balances Widget - Request Time Off (Desktop) 
WFR-147661: Users can Request Time Off from the Accrual Balances widget when they have the proper 
security permissions to do so. The Request button displays the name of the Accrual Balance rule/policy 
that is tied to the rule/policy listed first in the widget. The second, third, fourth, etc. listed buckets fall 
into the split button drop-down menu (for example, Request Vacation). 

The Request button is hidden if the user lacks permission to the Request Time Off security item in the 
assigned Security Profile (found in the Time Tracking section on the ESS tab). Tracking with the Request 
Time Off permission works similarly to the Time Off Balance page. 
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The selected value in the Accruals widget prepopulates the Time Off Type on the Time Off Request page. 

Announcements Widget in the New UI Dashboard (Desktop) 
139540: Users can view Active Date information, if it is set, and access the appropriate Announcement 
screen as a user or administrator from the Announcements widget when the Announcement widget is 
included into the New UI Dashboard Layout. Additionally, the user must have access to posted 
announcements based on Group or Security Profile settings defined per announcement.  

Up to 3 uploaded documents can be tied to an Announcement, and they are available to click in the list 
and in the pop-up upon clicking the listed Announcement. The Announcements widget is not displayed 
when no Announcements exist. 

When a user has access to Announcements (the Announcements security item is enabled in the Tools & 
Documents section on the ESS tab and in the Global Setup section on the Global tab of the assigned 
Security Profile), the Announcements widget title is a link that directs users to My Info > My Company > 
Announcements. 

Users can review the Active Date range for the Announcement details in both the widget view and in the 
widget pop-up (when clicking on in the widget and when the user logins and it appears). 

• When the From and To date are available, they appear below the Announcement title as Active 12-01-2019 
to 12-31-2019. 

• When just the To date is available, it appears below the Announcement title as Active until 12-31-2019. The 
Active Date cannot be saved without a To date.  

• When the Active checkbox is disabled, the Announcement item information does not display. 
• The Date Format shown is tied to the Company, EIN, and Locale settings. 
• Active date values replace Created dates, and users can no longer view the Created date and time. 

The message No data to display appears: 

• When the user does not have the appropriate permissions to see the widget. 
• When there is nothing/no data to display.  

Users are not able to control the number of Announcements that can be viewed in the widget at a time. 
Sorting is by Created date, with the most recently created Announcements at the top. 
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Names of Tiles Display Correctly in Re-arrange Menu (Desktop) 
153868: When a Landing or Domain Dashboard is opened and has at least two tiles as a Chart, upon 
switching the tile(s) to the Data Only mode and selecting Re-Arrange Tiles, the following apply:  

• For reports, the Report icon <Report name - Report view> is displayed. 

– The report icon and report name are not clickable. 
– The report icon and report name are black in color. 

• For charts, the Chart icon <Report name - Chart name> is displayed. 

– The chart icon and report name are not clickable. 
– The chart icon and report name are black in color. 

•  For widgets:  

– The widget icon and widget name are not clickable. 
– The widget icon and widget name are black in color. 

Updates to Tile Displaying after Deletion of Parent Chart / Report View / Report (Desktop) 
153901: When a tile is added as a chart to a Dashboard in a report view with 2 or more assigned charts, 
if the parent chart is deleted from the report view, the added tile is switched to the next chart from the 
set. 

When a tile is added as a chart to a Dashboard in a report view with only 1 assigned chart, if the parent 
chart is deleted from the report view, the added tile is switched to Data Only mode and the report view 
remains the same. 

When a tile is added to a Dashboard as a report in a custom report view, if the parent report is deleted 
from the report view, the added tile is switched to [System] report view in Data Only mode. The same 
occurs when a tile is added to a Dashboard as a chart in a custom report view and the parent report is 
deleted from the report view.  

If a parent report is deleted, the child tile is also deleted from the Dashboard. 

New Dashboard Tiles for Widgets (Desktop) 
145333: Default tiles appear in the New UI Dashboard Layout Configuration in Company Settings > 
Profiles/Policies > New UI Dashboard Layout > Edit. If a tile requires configuration in a layout profile (for 
example, Time Statistics):  

• Configure and Remove buttons are displayed (as is always the case for these types of widgets, even after 
configuration). 

• When a user clicks on Configure, a dialog box opens for widget configuration.  
• If the configuration screen is closed without saving the configuration, the Configure and Remove options 

display again. If the configuration is saved, the widget framework displays and the Configure and Remove 
buttons are still shown.  

• If a user wants to edit the configuration after saving, s/he can click the Configure button again, which opens 
the configuration dialog with the existing configuration. 

• If a user clicks Remove, the widget is removed from the display and the space is filled by other tiles. 
• If a user does not complete actions for the widget and save the Dashboard Layout, the tile is kept. The widget 

displays as blank on the end-user dashboards with no option to configure. A warning message on the blank 
tile on the landing page for the end user explains that the Widget has not been configured. Please 
contact your system administrator. 

– When a user again accesses the profile, the Configure and Remove buttons display.  
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If a tile requires configuration on the Landing Page (for example, Employee Perspectives, Sticky Notes): 

• The Remove button only displays in the Dashboard Layout Profile (as is always the case for these types of 
widgets). A warning message displays above the Remove button on the tile in the layout profile: Widget 
should be configured on landing page by manager with direct reports. 

• The Remove button is hidden under the ellipsis on the Landing Page of end users.  
• The Configure button appears on the Landing Page tile for end users if it has never been configured. Once 

configured, the end user has access to edit the filter or configuration via the filter icon or gear icon (based on 
the type of widget). 

If a tile does not require configuration (for example: Clock, Announcements): 

• The Remove button only displays in the layout profile (as is always the case for these types of widgets), and is 
hidden under the ellipsis on landing page of end user 

• If a user clicks Remove, the widget is removed from display and the space is filled by other tiles.  

Start Widget Configuration Icons and Colors (Desktop) 
148665: Users can view updates made to the Start widget Configuration Page so that interactions with 
the buttons are consistent.  

The default icon for the Add Photo functionality has been updated to ensure a consistent visual 
experience. 
 

           

Start Widget Updates in the New UI Dashboard (Desktop) 
153873: In the New UI dashboard, several improvements have been made to the Start Widget, such as: 

• The Icons are slightly larger and expand when hovered over. 
• The Categories remain closer together for improved visibility. 
• The long Category names are no longer truncated. 
• The Link lists are responsive to browser size changes. 
• The Link names are no longer truncated. 

Employee Banner for the Mobile Application (Mobile) 
159429: The Employee Banner now displays in the Mobile Application on the Home tab to improve the 
visual experience by adding color and strengthening the experience for users. The following data 
displays for the user:  

• The user's full name (First Name, Last Name) from their primary EIN account. 
• The user's Job/Position Title followed by the name of the primary EIN, separated by a comma. 

– If no Job or Position titles are available, the Job Title line does not display in the banner. 
– If the user has a saved Default Job in his/her profile and has saved Position data, the Job Position shows 

the Position value in the banner. 
– If the user has a saved Default Job in his/her profile and does not have Position data, the Job Title shows 

the Default Job in the banner. 
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• The user’s Employee ID in parentheses to the right of his/her name. 

The employee’s picture also displays in the top left corner. If no employee picture is uploaded, the 
employee’s initials with the blue background display. 

 

 

Technical Updates (Desktop) 

Warning Message to Verify Changes are not Saved (Desktop) 
157750: Administrators with permissions to View/Edit the New UI Dashboard Layout Profile (Company 
Settings > Profiles/Policies > New UI Dashboard Layout) receive a warning message to verify when 
changes have not been saved.  

When a user clicks to close out or refresh the browser window, clicks the browser back button, or clicks 
a navigational link in the application’s header, if unsaved changes exist, then:  

• A native warning message/pop-up from the browser appears that reads: Leave Site? Changes you made 
may not be saved.  

 
NOTE: The example above is from Google Chrome. The message may have a different look in other 
browsers.  

Warning Message Concerning Unsaved Changes (Desktop) 
146809: Administrators receive a warning message when changes haven't been saved when they have 
permissions to View/Edit the New UI Dashboard Layout Profile (Company Settings > Profiles/Policies > 
New UI Dashboard Layout).  

When a user clicks the Back button in the application or a link in the hamburger menu after making a 
change and not saving, a warning message/pop-up appears that reads: You will lose all unsaved 
changes. Continue? 
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If the user clicks CANCEL, s/he remains on the current page with the unsaved changes. If the user clicks 
OK, s/he is directed to a new page and the changes will not be saved. 

One Row Display for Landing and Domain Dashboards (Desktop & Mobile) 
159165: Landing and Domain Dashboards now display in one row. Users can scroll tabs if there is not 
enough space to display all tabs on the screen. 

 

Each Domain tab contains a New UI Dashboard. Reports and charts inside each tab include the same 
data as in the Module Dashboards in the main menu. 

Home Tab Created by Default with New Schedule (Desktop & Mobile) 
159976: A Home tab is now created by default when a new schedule has been assigned. When an Admin 
creates a new schedule and assigns a Dashboard Layout Profile with the schedule to employees, the 
system creates a Home tab for users and reproduces the same layout from the previous schedule. 

Color of Selected Dashboard Tab (Desktop) 
161300: The selected Dashboard category tab now displays in white to highlight what is selected and 
ensure that informational messages display in a different color.  

 

The layout controls appear below the row with the Dashboard tabs. The Saved View selector on module 
dashboards in the landing experience align with this row. 

Report/Chart Tile Mobile Adaptation for Desktop (Desktop) 
162408: The Mobile view is represented in the Desktop when the width of a tile is one column. When 
the width of a tile is two (or three) columns, the view of report is the normal view in a Desktop report. 

Improved Module View (Desktop & Mobile) 
162610: The employee banner has been removed from the Module Dashboards in the Hamburger 
menu. Additionally, on all Module Dashboards from the Hamburger menu (excluding the landing page), 
the Saved :[System] is positioned in the left corner.  
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Tile Quantity for Module Dashboards (Desktop) 
163196: The optimal and maximum quantity of tiles in a Domain Dashboard is now 9 in the Hamburger 
menu and on the Landing Page. On the Home tab, the maximum number of tiles is 20.  

 
New UI: Electronic Signature 

Biometrics Signature Enabled with Authentication Permission (Mobile) 
156554: Where applicable, Electronic Signature (Biometrics) enablement is now available under My 
Information > My Profile in order to give users an easier experience using biometrics for signature type 
activities.  

 

New UI: Employee Information 

Job Title in Employee Information & My Profile Header (Mobile) 
166559: In the New UI mobile environment, employee job titles were missing from the 
Employee Information and My Profile headers and have now been added.   

New UI: Employee Profiles 

Update Setup with Custom Placement of Options (Desktop & Mobile) 
142617: The Employee Profile and Applicant Profile have been updated so that the toggle between tabs 
is now to the right of the image instead of above the user’s image. 

         

NOTE: This change is applicable for the Employee Profile in the Mobile Application and the Applicant 
Profile in the Desktop and Mobile Application. 
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New UI: Employee Filters (Desktop) 

Advanced Filters (Desktop)  

Employee Filters: Set and Modify Advanced Filters (Desktop) 
82116: Users can now set and modify Advanced Filters when selecting employees via an Employee 
Filter. This allows users to retrieve data for the appropriate set of employees in reports. 

The Advanced Filter component is integrated into the Employee Filter on the Advanced Filter tab given 
that the Employee Filter is provided in the report. Users must activate the Employee Filter by clicking the 
Columns pill or Filter icon, then clicking Browse in the drop-down. 

 

Upon clicking the +Add Advanced Filter option, the Advanced Filter popup appears. The Select 
Parameter field displays by default and the Summary section shows (Undefined condition) until a valid 
condition is specified. 

When the user selects a parameter (filter type), then the full condition structure appears and can be 
configured. Clicking Apply activates the Advanced Filter for the Employee Filter, and the Employee Filter 
drop-down displays the Advanced Filter value in the Global tab of the Global Filter Panel. 

  

    

The Advanced Filter also appears in the blue pill of the report header. 
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Advanced Filter and Custom Filter (Desktop) 
146416: Users can open the Advanced Filter upon clicking on the Add Advanced Filter button and can 
open the Custom Filter by clicking on Add Custom Filter. Users can then use the +Add button to select 
the parameters for the Advanced/Custom filter.  

        

Advanced and Custom Filters – Mobile Application (Mobile) 
159996: On Mobile devices, the Advanced Filter and Custom Filter behave the following way: 

• Create & Edit Filter - On mobile devices, the Advanced Filter and Custom Filter do not provide the ability to 
Edit and Create a new filter. If no filter is already configured, when a user opens the Advanced Filter tab or 
the Custom Filter tab on a mobile device, the message No Custom(/Advanced) Filters are available. 

 

• Switch Filter On/Off – Users can switch Custom filters on/off, preserving the filter condition.  

 

• Delete Filter Users can remove/delete an Advanced Filter configuration on a mobile device. 

 

Complex Employee Lookup (Desktop) 
149310: Users have Advanced Reporting capabilities when they perform employee selection so that 
they can quickly find the proper employee(s) to perform an action. 

 



 
 

25 

 

 

The Available tab includes:  

• (Available) Employees  
• Company Groups 
• Company Profiles 
• Advanced Filter 

The Selected tab includes the selected data. Users select employee(s)/groups, then click Add To 
Selection/Apply, and the selected employee(s)/group(s) move from the Available tab to the Selected 
tab. 

  

Advanced Filter Criteria (Desktop) 

Employee Filter: Drop-Down Selector (Employee Type, Pay Type, etc.) (Desktop) 
144687: Users can set the Benefit Auto-Enrollment Eligibility, Contract Type, EIN, Employee Type, and 
Pay Type in the Advanced Filters tab of the Employee Filter.  

• Drop-Down Selector Types Setup - When the Employee Filter is provided in a report and a user adds a type, 
then the Type lookup is opened, the types are listed as: 

• Benefit Auto-Enrollment Eligibility - Allows users to filter the report by the eligibility value set for the 
employee. 

• Contract Type - Allows users to filter the report by the contract type. 
• EIN - Allows users to filter the report by EIN. 
• Employee Type - Allows users to filter the report by employee type (such as exempt, non-exempt, contract, 

etc.). 
• Pay Type - Allows users to filter the report by hourly, salary, etc. pay type values. 

 

NOTE: Each Profile is available based on modules/features enabled or multi-EIN is configured.  
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Employee Filter Advanced Filter for No Match (Desktop) 
156603: Users can set an Advanced Filter to retrieve no account, so that when the report loads it will 
not take a possible extended amount of time to load all available records. When a user selects the No 
Match filter type, then: 

• It appears with the label No Match in the filter condition. 
• The Filter Summary Expression is No Match. 

When the filter is applied, it returns no accounts in the results.  
 

 

Employee Filter: Advanced Filter - All Lookups (Desktop) 
145346: Users can set Lookup types in the Advanced Filters tab of the Employee Filter when the 
following criteria are met:  

• The Employee Filter is provided in a report and a user adds a type. 
• At least one group is created in an EIN. 
• At least one Account Custom Field is enabled for an EIN. 
• At least one manager level is enabled for an EIN. 
• At least one Shift Premium Definition is enabled for an EIN. 
• At least one Union definition is enabled for an EIN. 
• At least one Working Time Regulation is enabled. 

The following Lookup types can be configured:  

• Company Groups - Allows users to filter the report by a company group. 
• Custom: ##(Name of Account Field) - Allows users to filter the report by an Account Field tied to an 

employee's EIN account. 
• Manager: ##(Name of Manager Level) - Allows users to filter the report by a Manager Level tied to an 

employee's EIN account. 
• Specific Account - Allows users to filter the report by one employee's Account. 

Employee Filter: Advanced Filter based on Account Status and Benefit Plan Filter Types (Desktop) 
146409: Users can set Account Status and Benefit Plan as filters in the Advanced Filters tab of the 
Employee Filter.  

• Account Status - Allows users to filter the report by the account status of an employee, such as Active or 
Terminated. 

• Benefit Plan - Allows users to filter the report by a selected Benefit Plan. 
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Employee Filter: Advanced Filter based on Employee's Manager (Compare to Current User) (Desktop) 
149401: Users have the option to choose Employee's Manager (Compare To Current User) as an 
Advanced Filter to return all employees who report to the user who is logged in or the same manager as 
the user who is logged in.  

 

When the Same As is set to User, the filter retrieves all employees who report to the user who is logged 
in as the designated Manager type (Manager 1-6). When User's Manager is selected, the filter retrieves 
all employees who report to the same designated Manager type (Manager 1-6) as the user who is 
logged in. 

Employee Filter: Advanced Filter based on Benefit Auto-Enrollment Eligibility Last Update (Desktop) 
156601: Users can set an Advanced Filter condition for the Auto-Enrollment Eligibility Last Update 
Date, which retrieves all employee(s) who become(s) eligible for enrollment on/after/before the 
specified days/month/years from today.  

 

Employee Filter: Advanced Filter based on Service Hours As of Today (Desktop) 
156604: Users can filter accounts by the number of hours accumulated from a certain date until today's 
date to retrieve data using the Service Hours As of Today filter type. Users can specify the Primary Date 
as:  

• Employee's dates: 

– Date Hired 



 
 

28 

– Date Started 
– Birthday 
– Seniority Date 
– Date Re-hired 
– Review Date 
– Benefits Date 
– Frozen Benefits Date 

• Custom Date: The list of custom dates is configurable. 

 

Employee Filter: Advanced Filter based on Years As Of Today (Desktop) 
153997: Users can set Years As Of Today as an Advanced Filter to retrieve employees based on the 
period of time working for the company. The user specifies a date from the following: 

• Employee's dates: 

– Date Hired 
– Date Started 
– Birthday 
– Seniority Date 
– Date Re-hired 
– Review Date 
– Benefits Date 
– Frozen Benefits Date 

• Custom Date: The list of custom dates is configurable. 

 

Employee Filter: Advanced Filter for Employee In Between Date X and Y (Desktop) 
153829: Users can set the Employee In Between Dates X and Y filter to retrieve data for employees 
whose Day/Month/Year of the specified employee date satisfies the criteria. Users can set the filter to 
retrieve employees where: 

• The day of the specified employee's date is between <value from> and <value to>. 
• The month of a specified employee's date is between <value from> and <value to>. 
• The year of a specified employee's date is between <value from> and <value to>. 

The Employee Date type selector includes the following: 

• Employee Dates 

– Hired 
– Started 
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– Birthday 
– Seniority Date 
– Date Re-Hired 
– Review Date 
– Benefits Date 
– Frozen Benefit Date 

• A configurable list of Custom Dates. 

 

Employee Filter: Advanced Filter for Signed Opt-Out Document (Desktop) 
153996: Users can configure a Signed Opt-Out Document filter to retrieve a list of employees who 
have/have not signed the specified Opt-Out Document type.  

Users specify Accounts that: 

• Have signed the Opt-Out Document 
• Have Not signed the Opt-Out Document 

 

Employee Filters - Additional Types Added (Desktop & Mobile) 
149400: Users can now set additional filter types in the Advanced Filters tab of the Employee Filter tab. 
When an Employee Filter is provided in a report and a user adds a type, the Type lookup opens and lists 
the following types:  

• Is Female - Allows users to filter the report by an employee's demographic value of female. 
• Is Locked - Allows users to filter the report by employees' locked statuses. 
• Is Male - Allows users to filter the report by employees' demographic value of male. 
• Is Not Terminated - Allows users to filter the report by employees not terminated (Active, Not in Payroll, etc.) 

statuses. 
• Is Smoker - Allows users to filter the report by employees' demographic values of being a smoker. 
• Is Terminated - Allows users to filter the report by employees' terminated statuses. 

 

Employee Filters - Types Text Field (Desktop) 
145339: Users can set the county, state, and zip/postal code in the Advanced Filters tab of the Employee 
Filter tab where the Employee Filter is available in a report and the user adds a type. When the Type 
lookup is opened, the fields appear as follows:  

• Address: County 
• Address: State 
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• Address: Zip/Postal Code 

 

Employee Filters - Cost Center Types (Desktop) 
143461: Users can set Default Cost Center types in the Advanced Filters tab of the Employee Filter tab. 
The Default Cost Center (Compare To Current User) selection allows the user who is logged in to 
retrieve all employees who have the same Cost Center on a defined level of the Cost Center Tree. The 
filter can be set to level 1, 2, 3, 4, or Last.  

For example, if the user has a default Cost Center of US/California/California South/South Coast, and the 
Advanced filter is set for the 3rd level, then the filter results contain all accounts with a default Cost 
Center of US/California/California South. If an account's cost center path does not have a 3rd level 
(US/California) or the 3rd level is different (US/California/California West), then the account is not 
included in the results. 

When the filter is set to the last level (Last), all accounts with a default Cost Center full path that is the 
same as the user who is logged in are returned in the results. 

 

Users also have the option to filter on Default Cost Center # (1-9). This allows users to retrieve 
account(s) with the same full path as the one specified in the Advanced Filter for the Default Cost Center 
#. An option to Include Subtree can also be enabled to include accounts with the full path and lower 
levels than specified in the condition in the filter results. When Include Subtree is not enabled, the filter 
results contain accounts with a strict match to the full path of the Default Cost Center # specified in the 
Advanced Filter.  

 

Users can filter on the Default Cost Center # in Rate Table (1-9), which allows users to retrieve accounts 
with a specific Rate Table assignment. 
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Additionally, users have the option to filter by the Default Job (HR), which allows users to filter by the 
assigned Job value from the Jobs Cost Center Tree. Typically the lowest level in the hierarchy is assigned 
to the employee. 

Employee Filters based on HR Custom Fields Types (Desktop) 
143912: Users can set configured and enabled HR Custom Fields in the Advanced Filters tab of the 
Employee Filter.  

 

Users can define the following HR Custom Field types to filter by:  

• Characters (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by typing the 
characters tied to an HR Custom Value assigned to employees. 

• Currency (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by typing a 
currency amount tied to an HR Custom Value assigned to employees. 

• Date (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by choosing a date 
value, such as December 20th, 2019, tied to an HR Custom Value assigned to employees. 

• Email (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by typing an email 
address tied an HR Custom Value assigned to employees. 

• Integer (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by typing an 
integer, a whole number without decimals, tied an HR Custom Value assigned to employees. 

• Link (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by typing a currency 
value tied an HR Custom Value assigned to employees. 

• Numeric (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by typing a 
numerical value, including a decimal, tied to an HR Custom Value assigned to employees. 

• System Account (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by 
choosing an employee account tied to an HR Custom Value assigned to employees. 

• Time (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by typing a time 
value tied to an HR Custom Value assigned to employees. 

• List-enabled custom field (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report 
by choosing a value from a drop-down list tied to an HR Custom Value assigned to employees. This is 
applicable for each type above, when "Is list" is enabled and "Allow New" is not enabled.  

• List-enabled custom field, allowing new (Custom HR Field #:##(Name of HR Custom Field) - Allows users to 
filter the report by choosing a value from a drop-down list, including allowing a new value, tied to an HR 
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Custom Value assigned to employees. This is applicable for each type above, when "Is list" is enabled and 
"Allow New" is enabled. 

Employee Filter: Profiles (Union, Working Time Regulations, Default Shift Premium Types, etc.) (Desktop) 
143632: Users can set Profile types in the Advanced Filters tab of the Employee Filter.  

 

 
Users can define the following Profile types to filter by:  

• Profile: Accruals - Allows users to filter the report by a selected Accrual Profile. 
• Profile: Counter Distribution - Allows users to filter the report by a selected Counter Distribution profile. 
• Profile: Holiday - Allows users to filter the report by a selected Holiday profile. 
• Profile: Pay Calculation - Allows users to filter the report by a selected Pay Calculations 1 profile. 
• Profile: Pay Calculation 2 - Allows users to filter the report by a selected Pay Calculations 2 profile. 
• Profile: Pay Period - Allows users to filter the report by a selected Pay Period profile. 
• Profile: Pay Prep - Allows users to filter the report by a selected Pay Prep profile. 
• Profile: Points - Allows users to filter the report by a selected Points profile. 
• Profile: Retirement Plan - Allows users to filter the report by a selected Retirement Plan profile. 
• Profile: Scheduler - Allows users to filter the report by a selected Scheduler profile. 
• Profile: Employee Perspectives - Allows users to filter the report by a selected Employee Perspectives profile. 
• Profile: Security - Allows users to filter the report by a selected Security profile. 
• Profile: Time Off Planning - Allows users to filter the report by a selected Time Off Planning profile. 
• Profile: Timesheet - Allows users to filter the report by a selected Timesheet profile. 
• Profile: Work Schedule - Allows users to filter the report by a selected Work Schedule profile. 
• Union - Allows users to filter the report by a Union definition tied to an employee's EIN account. 
• Working Time Regulations - Allows users to filter the report by a Working Time Regulation definition tied to 

an employee's EIN account. 
• Default Shift Premium - Allows users to filter the report by a Default Shift Premium tied to an employee's EIN 

account. 

If the Company Profile Advanced Filter is applied and saved, and a profile used in the Filter Condition is 
removed, then: 

• The filter is preserved.  
• < Profile: Name (Deleted)> displays in the filter expression. 
• < Profile: Name (Deleted)> shows in the condition, while in the lookup field it is not visible in the list items. 

Exceptions are the Counter Distribution and Scheduler Profiles. Due to the approach taken for the deletion of 
these types, just the name of the profile shows in this case, without (Deleted) state.  

NOTE: Each Profile is available based on modules/features enabled or multi-EIN being configured. 
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Employee Filter: Display Logged-In User in the Lookup List (Desktop) 
163085: Managers can select themselves in the Employee Filter so they can share report data about 
manager and subordinates for auditing (HR Specialist/ Higher Level Management, etc.) purposes. Users 
can select all subordinates and themselves to build a report for audit and sharing. 

If the user who is logged in is not a self-manager, then upon applying the selection, the user cannot view 
their own data in report. As the report is shared with the HR Specialist/Manager who can access their 
data, they can view the information. 

 

Employee Filter Tabs/Profiles (Desktop)  

Employee Filter Profile Support - Profiles Tab (Desktop) 
154520: Users can utilize Company Profiles to more easily define a group of employees to run a report 
against. Users can select profile(s) to retrieve employees based on data defined on the Company Profiles 
tab. 

Supported Profiles include: 

• Timesheet Profile 
• Scheduler Profile 
• Security Profile 
• Accruals Profile 
• Holiday Profile 
• Pay Period Profile 
• Pay Rules Profile 
• Pay Calc Profile 
• Pay Calc 2 Profile 
• Counter Distribution Profile 
• Time Off Planning Profile 
• Schedule 
• Schedule Personal 
• Retirement 
• Employee Perspectives Profile 

Only active profiles display on the Company Profiles tab. Profiles must be assigned to at least one of the 
user’s employees to be visible on the Company Profiles tab, with the exception of the Schedule Personal 
profile, which is visible even if not assigned to any employees. The # employees reflects number of the 
user's employees with this profile assigned. The user who is logged in is included in the selection if s/he 
has the profile(s) assigned but is not included in the # employees. 

When the user selects the profile(s) and clicks Add to Selection, the selected profiles appear in the 
Selected tab within the Company Profiles section and disappear from the Company Profiles tab. 
Employees matching the selected Profile criteria also disappear from the (Available) Employees tab. 

When the user selects the profile(s) and clicks Apply, the profiles are automatically added to the 
selection and the full selection is applied. If multiple profiles are selected, then upon Apply, the selection 
is converted to an employee list. If a mixed selection of profiles is selected together with 
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Groups/Specific Accounts/Advanced Filters, employees matching the selection criteria disappear from 
the (Available) Employees tab. 

 

Selected Tab & Expand Selection for Profiles Filter (Desktop) 
64593: Users can view a Profiles filter applied in the Classic UI environment in the New UI environment 
on the Selected tab and can also add Employees/Groups/Advanced Filter to the selection to retrieve 
data for the proper employees. 

When a user selects a single Profile and applies the filter, the selected Profile is not expanded into a list 
of employees. In this case, when a new assignment of the Profile appears or an existing assignment is 
removed, it immediately affects the filter correspondingly (the employee is added or removed from the 
filter). 

Users can expand a Profiles filter applied in an employee list upon clicking Expand All to Employee List. 
NOTE: A single selected profile cannot be expanded into an employee list; only all selected profiles at 
one time. If a user expands a profile to a list of employees, the filter will retrieve only those employees 
who currently have that profile assigned. If employees are assigned/unassigned the profile, they do not 
impact the filter applied. 

• Users can select Employee(s)/ Group(s)/ Advanced Filter in addition to the Profiles filter configured in the 
Classic UI environment. When the user hits Apply, User will see only those employees from selected Profiles 
which the user has access to according to his/her security permissions. 

– Employees from the Employees list who are selected manually, employees from Groups and Profiles 
are merged into a single list. If the same employee is included in a group and profile or selected manually, 
then s/he displays only once in a merged list of employees. 

• The Company Profiles table will disappear from the Selected tab and Profiles become visible again in the 
Company Profiles tab of the Employee Filter. 

– In this case when a new assignment of the profile appears or an existing assignment is removed, this does 
not impact already configured employee filters based on the Profile(s).  

– If a user makes a mixed-selection of profiles together with Groups/Specific Accounts/Advanced Filters, 
employees matching selection criteria will disappear from the (Available) Employees tab. 

Employee Filter Profile Support - Remove from Selection (Desktop) 
154521: When a user removes a Company Profile from the Selected tab, then it appears on the 
Company Profiles tab. If a user cancels the lookup page after removal of the Company Profile from 
selection, then the Company Profile remains among those selected. 
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New UI: Platform 

Search Results Quality (All Environments) 
152591: We have improved the list of options returned when doing search in the Search box. For 
example, when searching on the term audit, a user looking for a report with the name that includes 
audit, previously returned a large number of non-relevant results due to other administrative areas of 
the system containing the same word. Users will now see the most relevant results at the top of the list, 
such as reports first, and other configuration areas after.  

Saving of Search Results (All Environments) 
147202: When users use the Search box, select a search item and return to the Search box, the last 
search results will be saved when users place their cursor in the field. The search results will be saved for 
the logged in session only and for the same browser. The X icon will allow the search criteria to be 
cleared.  

Updates When Searching Employees (Desktop & Mobile) 
150209 & 150870: When using the Search box to search for employees, a visual representation of the 
employees will display, along with quick links. The employee name will display as a clickable link, along 
with either their profile picture, or employee initials (if no picture is on file.) 

 

Report Based Single Select Employee Lookup (Desktop & Mobile) 
154897: Simple table based Single Select Employee Lookups have been replaced with report based 
Single Select Employee Lookups throughout the system.  

Report Based Multi-Select Employee Lookup (Desktop & Mobile) 
154967: Simple table based Multi-Select Lookups have been replaced with report based Multi-Select 
Lookups throughout the system. 

Simple & Complex Employee Lookups Width (Desktop & Mobile) 
163087: The Simple and Complex Employee lookups width is extended to 1280px in case screen 
resolution is 1400px and more. 
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Single and Multi-Select Lookups: Report Table Based (Desktop) 
147253: Users now have advanced reporting capabilities when performing single or multiple object 
selection, allowing them to quickly find the proper object(s) to perform an action. Users can perform 
single employee select upon clicking on radio-button in the corresponding employee row and clicking on 
one or more checkboxes for multiple employee selection. 

 

     

The following Actions are supported by reports in the lookup: 

• Refresh 
• Reset 
• Save View 
• Save View As 
• Manage Views 
• Sort/Multi-Column Sort 
• Add/Remove Columns/Export 
• Export Settings 
• Print  

Users can filter the list of items by column using an inline filter area (expanded/collapsed state is 
determined by the Saved View; it is expanded by default) or by using the Global Filter panel.  

When a user makes a selection in single select/multi select lookup, when the user switches to another 
view, the previously made selection is cleared. 

• In a Multi-Select lookup, when a user makes a selection of some item(s)/account(s) within one view and then 
switches to another view, the previous selection is cleared upon switching the view. Only the selection made 
in the current view is applied when the user clicks Apply. 
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– For single-select lookup, when the user makes a selection on one page and then switches to another page 
and makes a selection, the latest selection overrides the previous selection. 

– For multi-select lookup, when the user makes selections on different pages, then all items selected on all 
pages are included in the selection. 

• When a user applies the selection, opens the lookup again and switches to another view, the user sees no 
selection. The view returns back to the default view, and the user sees no selection. If the user closes the 
lookup in this case, the original selection(s) is preserved unless the user hits Apply. In this case, the original 
selection(s) are lost. 

NOTE: In an Internet Explorer browser, when a user adds more than 15 columns, a message displays 
explaining that not all columns are visible in IE, but the user can see all columns in another browser. This 
limit is only applicable to IE browsers. 

Pinned Menu Option (Mobile) 
84584: Users can pin the main menu so they can load different pages within the system by simply 
clicking on options within the menu. The menu is pinned for just one log in session, and when the menu 
is pinned, the display is moved to the right to prevent overlay and the Close (X) button is outside of the 
menu. The Home icon remains to left of the pin icon. 

       

The display on the Mobile App is determined by resolution 

Pinned Menu Function Beyond Log In Session (Desktop) 
155479: When the main menu is pinned, the pinning remains beyond just the login session so users do 
not need to reset it every time. When users log in a second time, the menu is still extended. If the menu 
is not pinned open, then when users log back in, it is still collapsed. 

If the menu is pinned open and the page is refreshed, the menu is pinned open after the refresh.  

Prompt User for Review/Rating (Mobile) 
153378: In the Mobile Application, the user is presented with the review/rating prompt after a trigger 
occurs where s/he can successfully enter a rating and add comments. Upon a successful first punch out 
or first change of cost center (can result in a punch in or punch out), or a simple punch (can result in a 
punch in or punch out) from the Timesheet or the clock widget will trigger the review/rating prompt. If 
this is not done after the first 5 minutes of active or idle time, then when a user navigates to another 
page, the trigger occurs.  
 
Typically, the popup is displayed upon triggering each time unless the following selections are made:  

• The popup is not displayed during the current session after the user chooses No, Thanks. 
• The popup is not displayed until the mobile app is re-installed or the cache is cleared after Rate It Now is 

chosen.  
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• The popup is displayed upon the next trigger after Remind Me Later. 

 

Update Menu Picture in the Hamburger Menu (Mobile) 
156612: The Picture component within the Mobile experience has been updated and now uses a circle 
rather than a square. Pictures almost in all places have no border and do not support navigation to 
employee profile, as usually there is an employee name next to the photo which serves as a link to 
employee profile. 

Hide/Disable Back Button After Login (Mobile) 
147245: The Back button is disabled on the landing experience for any first page configuration or 
navigation back to the Homepage to prevent users who just logged in from being logged back out upon 
clicking on the Back button.  

Feature Retirements 
The tables below document functionality that has been retired or is planned to be retired. These 
tables will be updated as needed with every system release.   

Retired Features 
Product/ 
Component 

Feature  Menu Path  User 
Experience 

Reason Planned 
Retirement 
Date 

Platform HTML 
Code in 
the HTML 
Editor 

Multiple - 
System wide 

Classic UI 
and New 
UI 

This feature will 
be removed due 
to a potential 
security 
vulnerability 

December 
2019 
 

      
      
Scheduler Menu 

Removed 
Team > 
Schedule > 
Team Schedule 
View > 
Overview > 
Overview 

New UI 
Desktop 

Consolidated the 
view under one 
Overview menu 
item.  
Team > Schedule 
> Team Schedule 
View > Overview > 
Schedule 
Overview 

December 
2019 
 

Scheduler Menu 
Removed 

Team > 
Schedule > 
Team Schedule 
View > 
Overview > 
Overview 
(Monthly) 

New UI 
Desktop 

Consolidated the 
view under one 
Overview menu 
item.  
Team > Schedule 
> Team Schedule 
View > Overview > 
Schedule 

December 
2019 
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Overview 
Scheduler Menu 

Removed 
Team > 
Schedule > 
Team Schedule 
View > 
Overview > 
Overview 
(Weekly) 

New UI 
Desktop 

Consolidated the 
view under one 
Overview menu 
item.  
Team > Schedule 
> Team Schedule 
View > Overview > 
Schedule 
Overview 

December 
2019 
 

 

Planned Retirements 
Product/ 
Component 

Feature  Menu Path  User 
Experi
ence 

Reason Planned 
Retirement 
Date 

TLM > Timesheet 
Profiles 

Non-
supported 
Timesheet 
Profiles 

Company Settings > 
Profiles/Policies > 
Timesheets 

New 
UI 

Non-Supported 
Timesheet 
Profiles  

October 
2020 
 

Scheduler> 
Schedule 
Templates 
 

Schedule 
screen 

Scheduler > 
Schedules > View by 
Employee 

New 
UI 

Replaced with 
new schedule 
views 

TBD 

Scheduler> 
Schedule 
Templates 
 

Schedule 
screen 

Scheduler > 
Schedules > View by 
Cost Center 

New 
UI 

Replaced with 
new schedule 
views 

TBD 

Scheduler> 
Schedule 
Templates 
 

Schedule 
screen 

Scheduler > 
Schedules > Schedule 
Table View 

New 
UI 

Replaced with 
new schedule 
views 

TBD 

Scheduler> 
Schedules 
 

Schedule 
screen 

Scheduler > 
Schedules > View by 
Employee 

New 
UI 

Replaced with 
new schedule 
views 

TBD 

Scheduler> 
Schedules 
 

Schedule 
screen 

Scheduler > 
Schedules > View by 
Cost Center 

New 
UI 

Replaced with 
new schedule 
views 

TBD 

Scheduler> 
Schedules 
 

Schedule 
screen 

Scheduler > 
Schedules > Schedule 
Table View 

New 
UI 

Replaced with 
new schedule 
views 

TBD 

Scheduler> 
Schedules 
 

Schedule 
screen 

Scheduler > 
Schedules Overview 

New 
UI 

Replaced with 
new schedule 
views 

TBD 



 
 

40 

 

Human Resources 
Benefit Plans 

Prorate Settings Added to Deduction/Earning in Coverage Based Plans (Classic UI & New UI) 
110250: For Coverage Based benefit plans, two new proration settings have been added to the 
Deduction/Earning section. The Prorate Employee and Prorate Employer settings provide two options: 
Remaining Pays and Off. When set to Remaining Pays, the system will prorate an HSA or FSA deduction 
based on the remaining pay periods left in the year. 

For example, if a new employee hired in the middle of August enrolls in an FSA for $1000 and there are 
11 pay periods left in the year, the system will take the $1000 election and divide by 11 pay periods. 
$1000/11 = $90.91 per pay period. 

NOTE: The proration settings will not work if the employee has no Pay Period Profile assigned, as the 
system would have no way of knowing how many pay periods are left.  

If an existing benefit plan is using an existing prorate function that was already in place prior to this 
release, those plans will continue to use the old function until you edit the plan to use the new function. 
Once edited to use the new proration method, you will not be able to switch back to the old method.   

 

Change to Editing Earning/Deduction Codes in Benefit Plans (Classic UI & New UI) 
102536: In a previous release, we added the ability to change an Earning or Deduction code on a benefit 
plan even if it was already assigned to employees. Because the ability to do this resided at the child (sub-
plan) of the benefit plan, it was possible to accidentally delete a code which then affected the parent 
level of the benefit plan.  

To prevent accidental deletion of Earning or Deduction codes in these cases, only the parent benefit 
plan can now be edited. The Earning and Deduction fields in the child plans will be grayed out.  

Benefit Plan (Parent) – Can change Deduction/Earning and will flow out to child 
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Edit Plan (Child) – Earning/Deduction grayed out 

 

 
Affordable Care Act (ACA) (Classic UI & New UI) 

1095-C Forms Added For Employees: Nonemployee for Part of the Year (Classic UI & New UI) 
159600: When users chose the Mass Add For Selected Year option for the Form 1095-C, the system 
determined the employees who should receive a Form 1095-C for that year. The identification process 
did not include individuals who were assigned to the Non-Employee ACA Profile for part of the year and 
assigned to an active ACA Profile for the other part of the year.  

The system no longer excludes those employees in the process, and a Form 1095-C now generates for 
them along with all other employees who meet the criteria. The system will Mass Add a 1095-C Form for 
any employees with an ACA Status of FT for at least one month of the selected year, as well as any 
employees who do not have an ACA Status of FT but who are enrolled in a self-insured medical plan 
during the selected year. 

 
Employee Information 

Auto Update PP in Year Not to Impact Historical Base Compensation Records (Classic UI & New UI) 
151395: In the February 2020 system release, a new global setting was introduced to automatically 
update the PP In Year value in base compensation when pay period profiles are changed. When this is 
enabled, by default, only the top-most (current) base compensation PP In Year values are updated 
when pay period profiles are changed. 

When editing historical base compensation records, the PP In Year value was automatically updated to 
inherit the current pay period profile value. This can create an instance where a user updates an 
historical record's rate or effective date but does NOT want the PP In Year value updated. 
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To ensure this does not happen, when Auto Update Base Compensation PP In Year is enabled globally 
and users are editing historical, non-current base compensation records, the PP In Year value will not 
be updated and will remain as it was originally entered. 

HR Actions 

My Information Action Request Added to All HR Action Requests Report (Classic UI & New UI) 
161124: In the All HR Action Requests report, we will now show data for the My Information Action 
Request HR Actions, including history, pending, and future dated items.  

Having this information available will help users by creating an audit trail for certain items and reviewing 
for mistakes. Previously, only information for the My Employee Action Request displayed in the report.  

The report is located under My Info > My Reports > HR Reports > Employee Maintenance > All HR 
Action Requests.  

Important Note: This functionality was released in the February 2020 system release under 76084 and 
was later reverted (removed) until certain issues could be resolved. They have now been resolved and 
the functionality is available in this May 2020 release.   

 

The security setting controlling access to this report has been updated as well.  

On the Reports tab of security profiles, in the Employee Information Reports section, a new View My 
Information type HR action request setting has been added to the All HR Action Requests setting. When 
checked, users will be able to see the My Information Action Request data in the report.   

 

HR Setup – Scheduled Event 

Employee Checklist Added to Scheduled Events (Classic UI & New UI) 
145330: We have added Checklist as a selection in the Event Type drop-down for scheduled events, 
configured under Company Settings > HR Setup > Scheduled Event. Once selected, an Event drop-down 
will display where users can select from a list of checklists. 

This option will allow companies to schedule an event for checklists, assign the event to one or more 
employees, and if needed, schedule the event.   



 
 

43 

 

 

Imports 

Manager Fields Added to Employee Job History Import Template (Classic UI & New UI) 
18156: In the Employee Job Change History import template, we have added the Manager 1-6 fields to 
the template to support the importing of these fields into the Job Change History widget of employee 
accounts. These fields will include manager fields for Multi EIN and single companies. The template is 
located in the HR category under Company Settings > Imports > Overview.  

 

Total Deductions Added to External Pay History Import Template (Classic UI & New UI) 
153561: In the External Pay History import template, Total Deductions has been added. This is available 
in both the Excel and Excel 2007 templates. The templates are located in the Payroll category under 
Company Settings > Imports > Overview. 

 

Additionally, Total Deductions has been added as an available column that can be pulled into the Pay 
Statement History (Imported) report, located under Team > Payroll > Reports > Pay History. 

Multi EIN & National ID 

Removal of Overriding Permission for Primary National ID Type 
151706: Managers will now be able to hire an employee in a Multi EIN company according to the 
permissions set for the Primary National ID Type in the user’s security profile. Previously, the system 
allowed overriding of the user’s permissions and followed the same process as Social Security Numbers; 
i.e., if a user didn’t have permission to view/edit the SSN, they could still hire an employee because SSN 
was required for hiring. 
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Notifications 

Tag Added to ‘Applicant Applied For Job’ Notification (Classic UI & New UI) 
153737: In the Applicant Applied for Job notification, a new Applicant ID tag has been added and can be 
used when writing the message in the Email/Mailbox Message widget. When adding the tag, the 
applicants assigned ID will be included in the resulting email.    

 
Reports 

Skills Report Page: New ‘Is Schedulable’ Column Added if Using Scheduler Module (Classic UI & New UI)  
152460: To allow users to sort and filter the Skills report page by schedulable skills, a new Is Schedulable 
column is now available in the report. The Scheduler module must be enabled, and the column will be in 
the report by default. Column values are Yes or No. For HR and TLM, the report page is under Company 
Settings > HR Setup > Skills. For Scheduler, the report page is under Company Settings > Scheduler 
Setup > Skills. 

Workflows 

Additional Tags Added to Generate Notification Step in HR Action Workflows (Classic UI & New UI) 
132094: In HR Action workflows, the Generate Notification step has been updated with additional tags, so 
more information is automatically populated without users having to find and add it manually. 

The following new tags populate information from Employee Information: 

• Employee Id 

• Account Extra Fields (separate tags for account extra fields 1 to 10) 

• Employee Primary Email 

• Employee Secondary Email 

• Worker Type 

• EIN 

• Hired Date 

• Started Date 

The following new tags populate information from the HR Action: 

• HR Action Name  

• Termination Date 

• Termination Reason 

• Termination Notice 

• Termination Notes  

• Default Cost Centers (separate tags for cost centers 1 to 9) 

• Employee Type 

• Managers (separate tags for managers 1 to 6) 



 
 

45 

• Pay Grade 

• Account Status   

 

The following new tags populate information from the HR Action: 

• HR Action Name  

• Termination Date 

• Termination Reason 

• Termination Notice 

• Termination Notes  

• Default Cost Centers (separate tags for cost centers 1 to 9) 

• Employee Type 

• Managers (separate tags for managers 1 to 6) 

• Pay Grade 

• Account Status 

   

New UI Updates – Table of Functionality Added to New UI 
The table below shows the updates made within the New UI and the functionality added.   

Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

114018 
(EPIC) 
119047 

HR HR 
Actions 

EIN 
Transfer 

Team > HR > HR 
Actions 

Available Tab > 
Click Start 

Transfer 
employees 
from one EIN 
to another. 
Employees in 
EIN 
Selection of 
Terminated 
employees 

Yes Yes 

114018 
(EPIC) 
119049 

HR HR 
Actions 

 EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 
 

Upon Submit, 
workflow starts 
To Do Items  
(Approve/Reject
/ 
Modify) 
supported 
Supported 
standard fields 
include: Date 
Hired, Name, 

Yes Yes 
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Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

Started, Pay 
Period Profile, 
Personal 
Settings (these 
fields are pre-
filled with data 
from employee’s 
current EIN 
record) 
Large list of 
additional items 
can be added, as 
in other HR 
Actions.  

114018 
(EPIC) 
119544 

HR HR 
Actions 

EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 
 

Primary EIN with 
drop-down 
added to EIN 
Transfer 

Yes Yes 
 

114018 
(EPIC) 
119538 
119539 

HR HR 
Actions 

EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 

Deductions & 
Earnings HR 
Action Item Added 
to EIN Transfer 

Yes Yes+ 
 

114018 
(EPIC) 
119542 

 

HR HR 
Actions 

EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 

Termination 
Details Added to 
EIN Transfer 

 Yes 
 

114018 
(EPIC) 
119541 

 

HR HR 
Actions 

EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 

Job Change 
History Added to 
EIN Transfer 

 Yes 
 
 

114018 
(EPIC) 
119543 

 

HR HR 
Actions 

EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 

Inventory 
Profiles Add to 
EIN Transfer 

Yes Yes 
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Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

114018 
(EPIC) 
119051 

 

HR HR 
Actions 

EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 

Incidents History 
Add to EIN 
Transfer 

Yes Yes 
 

114018 
(EPIC) 
161811 

 

HR HR 
Actions 

EIN 
Transfer 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 

EIN Transfer Item 
for HR Actions 
The ‘Required’ 
checkbox has 
been disabled for: 
Account 
Checklists 
Account 
Checklists History 
Incidents History 
Job Change 
History 
Termination 
Details History 

Yes Yes 

144429 
(EPIC) 
147868 

 

HR Benefit 
Plan in HR 

Action 

Company Settings 
> HR Setup > HR 

Actions 
Team > HR > HR 

Actions 

Hire HR Action 
Adding Benefit 
Plan during hire 
process 
Account Contacts 
updated to New UI 

Yes Yes 
 
 

144429 
(EPIC) 
148347 

HR Benefit 
Plans 

Team > Benefits > 
Benefit Plans 

Account Contacts 
updated to New UI 
(adding & editing) 

Yes Yes 
 
 

 
New UI: Benefits 

Requested Amounts Added on Benefit Change Request PDF 
141133: In the PDF available from the benefit Change Requests Detail page (Team > Benefits > 
Enrollment Requests - exporting as PDF), any Guaranteed Amounts will now be included in the resulting 
PDF. Previously, they were not included.  

Benefits Enrollment – New Selection Option 
125029 & 137460: A new benefit selection option is available to employees that allows them to select all 
current plans configured with Use Units or EOI options. Previously, if a benefits plan required the 
selection of units or EOI, the option to select all current plans was disabled. Now, employees can select 
this option, so they won’t have to individually re-select their plans. 

This option can be controlled. A new Enable Enroll In All Current Benefit Plans checkbox has been 
added to the Benefit Profiles maintenance page.  
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• When checked, anyone assigned to that benefit profile will see the option to enroll in all current benefit plans 
during their open enrollment (no need to select each plan if no changes.) 

• When unchecked, the option to enroll in all current plans will be hidden from all employees assigned to that 
benefit plan profile. 

• The option will be unchecked by default.  

   

 

EOI Settings Added to Coverage Amount Based Benefit Plans on Coverage Levels w/o Units 
127225: Benefit plans based on coverage amount not requiring the use of units can now be configured 
with EOI settings at the coverage level(s). Three new checkbox options are now available in benefit plan 
coverage levels for Coverage Amount based benefit plans: 

• Require Evidence of Insurability for Open Enrollment 

• Require Evidence of Insurability for New Hire Enrollment 

• Require Evidence of Insurability for Life Change Event  

The benefit plan types are: 

• Coverage Amount 

• Coverage Amount/Age 

• Coverage Amount/Age of Dependents 

• Coverage Amount/Age of Spouse 

The following can be expected: 

• If any of the checkboxes are checked in the EOI Settings on the coverage level, the Guaranteed at option will 
be disabled.  

• If the Guaranteed at option is enabled, the three new checkboxes for EOI will be disabled. Users can only 
configure either the Guaranteed at or the EOI settings. 

• If the Use Units option is checked at the benefit plan level, the EOI settings will be disabled at the coverage 
level. If the EOI settings are used at the coverage level, the Use Units will not be grayed out, but when users 
check Use Units for a benefit plan level, the options are grayed out for EOI settings at the coverage level. 
You can use one option or the other, but not both. 

• If any of the checkboxes are checked, the plan will require an EOI upload from an employee if they are 
enrolling in any coverage level using the enrollment type specified in the checkbox(es). 
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• EOI upload, based on the three checkboxes will be applicable during ESS enrollments but not during the 
manual addition of plans, or when adding to the employee's record manually, or via import or API. 

• In the Benefit Change Request Detail report, the Is Evidence of Insurability Required column will contain a 
Yes if any of the three new checkboxes in non-unit plans are checked. 

 
New UI: Employee Filter 

Employee Filters based on HR Custom Fields Types (Desktop) 
143912: Users can set configured and enabled HR Custom Fields in the Advanced Filters tab of 
the Employee Filter.  

 

Users can define the following HR Custom Field types to filter by:  

• Characters (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the 
report by typing the characters tied to an HR Custom Value assigned to employees. 

• Currency (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the 
report by typing a currency amount tied to an HR Custom Value assigned to employees. 

• Date (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by 
choosing a date value, such as December 20th, 2019, tied to an HR Custom Value assigned to 
employees. 

• Email (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report 
by typing an email address tied an HR Custom Value assigned to employees. 

• Integer (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report 
by typing an integer, a whole number without decimals, tied an HR Custom Value assigned to 
employees. 

• Link (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by 
typing a currency value tied an HR Custom Value assigned to employees. 

• Numeric (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the 
report by typing a numerical value, including a decimal, tied to an HR Custom Value assigned 
to employees. 

• System Account (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter 
the report by choosing an employee account tied to an HR Custom Value assigned to 
employees. 

• Time (Custom HR Field #:##(Name of HR Custom Field) - Allows users to filter the report by 
typing a time value tied to an HR Custom Value assigned to employees. 

• List-enabled custom field (Custom HR Field #:##(Name of HR Custom Field) - Allows 
users to filter the report by choosing a value from a drop-down list tied to an HR Custom Value 
assigned to employees. This is applicable for each type above, when "Is list" is enabled and 
"Allow New" is not enabled.  
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• List-enabled custom field, allowing new (Custom HR Field #:##(Name of HR Custom 
Field) - Allows users to filter the report by choosing a value from a drop-down list, including 
allowing a new value, tied to an HR Custom Value assigned to employees. This is applicable 
for each type above, when "Is list" is enabled and "Allow New" is enabled. 

 

 
New UI: Employee Information 

Job Title in Employee Information & My Profile Header (Mobile) 
166559: In the New UI mobile environment, employee job titles were missing from the Employee 
Information and My Profile headers and have now been added.   

New UI: E-Verify 

Option Added to Require I9 Document Upload & Prompt for E-Verify (Desktop) 
141901: For companies using E-Verify, you can have your managers complete the I9 process in OnePoint 
HCM and then enforce a step ensuring the completed I9 is sent to E-Verify. We have added new settings 
for each hiring state that can control the prompting of users in submitting I9 forms to E-Verify. 

We have added an Override Use Online Form I9 column in the Hiring Sites section of the E-Verify 
Marketplace Product Settings. This column contains a drop-down for each state added. Options include 
Optional, Always, and Never. Note that these are the same options available in the Use Online Form I9 
drop-down in the E-Verify Configuration section but are now offered at the state level.   

We have also added an E-Verify Required checkbox for each state listed. 

NOTE: In the December 2019 release, this functionality was made available for the New UI Mobile 
experience. We are now making it available for the New UI Desktop experience in this release.   

 

How the new E-Verify settings work 

• States set as required/always will prompt the user, after completing the I9, and be presented with a pop-up 
to proceed with E-Verify.  

• When a new state is added, the E-Verify Required checkbox will be automatically checked for that state if any 
other states are set as required. If no states are set as required, the newly added state will be 
unchecked/unrequired, and options can be adjusted accordingly. 

• For any states set as required, the override column will be set to Always and cannot be changed unless the 
required checkbox is unchecked.  
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• If the user was forced to upload documents (see above), once uploaded, they will then proceed to E-Verify 
based on state’s settings. 

 

Message When User Navigates Away Without Submitting E-Verify Request 
145328: In the December 2019 system release, functionality was introduced so if E-Verify Required is 
enabled for a State in the E-Verify marketplace settings, the user would be directed to the E-Verify 
Screen after certifying the I9 (via the wizard approach.)  

In this release, we are adding behavior in the application to help ensure the user clicks Submit on the E-
Verify page.  

If E-Verify is marked as required when the user is brought to the E-Verify page, they will not be able to 
navigate away from the page prior to pressing the Submit button. If they do, they will receive a message 
that they must submit the E-Verify to exit. 

Verification of Submitted I9 Form Used in E-Verify Cases 
149004: In the New UI, the system will now indicate which I-9 form was used in the E-Verify submission 
process to help users quickly confirm which employee I-9 form was sent to E-Verify.  

In the E-Verify Requests report page, the Form I9: Status column will display the status of the form as 
links. When the links are clicked, the user will be directed to the submitted I9 form. 

  

New UI: HR Actions 

HR Action Item – Deductions (Mobile & Desktop) 
78426: The Deductions HR Action Item is now available and supported in the New UI for both MSS 
(Managers) and ESS (Employees).   

MSS 

This is valid for My Employee Action Request using sub-types Regular, Hire, Re-Hire, 
Termination, and EIN Transfer. This action item will update the Deductions widget in employee 
accounts and other areas in the system where deductions are supported.  

ESS 

WFR-91056 This is valid for My Information Action Request. When employees receive an HR 
Action To Do Item they can do things such as adjusting 401K elections, HSA amounts and FSA 
contributions. 
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Changing Default and Limit Cost Centers via HR Actions 
70947: Previously, when using an HR Action to update or change a cost center limit list or a 
default cost center, the system would not allow the update and an error message was 
generated due to the system looking at the current limit list, rather than the updated list. Now, 
when a limit list and cost center is updated on one HR Action at the same time, the validation 
will be based on the limit list provided in the HR Action and the update will be allowed.  

NOTE: Functionality is dependent on Default Cost Center and Limit Cost Center items being 
configured in the same HR action Group. 

New UI: Position Management 

Position Abbreviation Field Expanded 
148129: The Position Abbreviation field has been expanded from 12 to 60 characters. This field can be 
accessed when creating or editing Positions under Company Settings > HR Setup > Positions.  

Position Reports: Abbreviation and Title Columns Added 
148137: Within Position Management reports, the Abbreviation and Title fields have been added as 
available columns within the following reports. 

• Employee Assignments (Team > My Team) 

• Exceptions for Reports To Position (My Info > My Reports > Team Reports) 

• Position Headcount Detail (My Info > My Reports > Team Reports) 

• Position Headcount Summary (My Info > My Reports > Team Reports) 

• Employees Missing Primary Position (My Info > My Reports > Team Reports) 

• Position History (My Info > My Reports > Team Reports) 

Position Reports: Primary Position Columns Added to Job Change History Report 
151646: Three new Primary Position columns are available to be added to the Job Change History 
report, located under My Info > My Reports > HR Reports > Employee Maintenance > Job Change 
History.  

• Primary Position End Date 

• Primary Position Name 

• Primary Position Start Date 

Position Reports: Primary Position Columns Added to Employee Information Report 
151644: Three new Primary Position columns and position data enabled at the company level are 
available to be added to the Employee Information report page, located under Team > My Team > 
Employee Information.  

• Primary Position End Date 

• Primary Position Name 
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• Primary Position Start Date 

• All Position attributes enabled in Company Setup 

Position Reports: Position Information Added to Termination Details Report 
151645: The following columns can now be added to the Termination Details Report. These columns will 
populate based on the assignment data as of the employee’s termination date. Only Primary 
assignments will display in these columns. 

• Primary Position 

• Primary Position Start Date 

• Primary Position End Date 

Position Lookups in Assignment Pop Up: Past Dated Assignments 
156660: When an employee’s Position Assignment is ended with a back-dated Position, any subordinate 
Positions in effect up to end-dated one will no longer be displayed in the Position lookup within the 
Assignment pop-up. For example: 

• Mary is assigned to Position A as primary - Position A has Positions 1, 2, and 3 as subordinate. 

• Mary is also assigned to Position B as non-primary - Position B has Positions X and Y as subordinate. 

• If a user end dates Mary's assignment to Position B with a date in the past, the next time Mary logs into the 
system she will no longer see Positions X and Y as options in the Positions lookup list within the Assignment 
pop-ups.  

Position Imports: Behavior of Assignment Change Reason on Employee Position Assignment Import 
141231: When importing the Assignment Change Reason field on the Employee Position Assignment 
import template, the system will now look at the value set in the Position Management widget in 
Company Setup. This ensures the correct value is assigned or skipped.    

 

Company Setup Values in the Position Management Widget 

• Hidden – If a value is entered in the import template, the system will ignore it since the value is not to be 
viewed by the users. If no value is entered in the import template, the system will ignore the value and will 
not generate an error since the value is to be hidden.  

• Not Required – If a value is entered in the import template, the system will check the change reasons at the 
Position level and populate accordingly since the value is not required, nor hidden. If no value is entered in 
the import template, the system will not generate an error since the field is not required.   

• Required – If a value is entered in the import template, the system will check the change reasons at the 
Position level.  
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– If a valid match is found, the system will populate the value upon importing.  

– If no value is entered in the import template, an error will be generated in the import results since this is 
required. 

– If you enter Clear to remove an existing reason code, an error will be generated in the import results since 
this is required.   

Assignment Change Reason Code Added to Rehire Type HR Action 
151623: When using the Rehire type in HR Actions to hire an employee into a different Position, an 
Assignment Change Reason Code can now be applied during the rehire process.  

Assignment Change Reason Code Added to Manual Hire 
151619: When manually hiring an employee into a Position using the Hire option in Employee 
Maintenance, an Assignment Change Reason Code can now be applied during the hire process. 

Assignment Attributes in HR Actions 
151616, 151612, 151614 

When using an HR Action to assign an employee into a Position, you can now enter any assignment 
attributes that might be required. Once the HR Action is approved, the employee record will be 
updated.  

Ensure the following is set: The Enable Employee Assignment Attributes field is set to Yes (Position 
Management widget on the HR tab, located at Company Settings > Global Setup > Company Setup.) 

HR Actions Supported: 

• Regular 

• Hire 

• Rehire 

New UI: Recruitment – Communication Templates 

Errors When Sending Communications with iCalendar Enabled 
134820: Previously, when a communication template with iCalendar Attachment enabled was 
sent from a job requisition or job application, users received an unclear error messages and the 
message could not be sent.  Now when sending a communication with iCalendar Attachment 
enabled via Email, Mailbox, or SMS, no error message will be generated.   

New UI: Recruitment – Job Applications 

Button Order Reconfigured on Job Applications Page 
153788: The button order on the Job Applications page (Team > Recruitment > Candidates > Job 
Applications) have been rearranged. The new arrangement is valid on the New UI Desktop and New UI 
Mobile experience. The new order from left to right is: 

1. Add Evaluation Questionnaire 

2. Update Hiring Stage 

3. Communicate 
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4. View 

5. Ellipses – Update Application Rank 

New UI: Recruitment – Hiring Stages in Job Requisitions & Templates  
147526, 151467, 154574, 149167, 162207, 160915 

Background 

Up to this system release, all hiring stages applied to all job requisitions and users could not 
make specific hiring stages enabled or disabled, required, or control and enforce the sequence 
order in which they were to be completed per each job requisition. Nor could they prevent the 
applicant from being hired if required hiring stages were not completed. 

What we Have Done 

Now, hiring stages have been added to the job requisition level as well, where administrators 
can control enabling/disabling, editing the sequence order, enforcing the sequence order, and/or 
marking certain hiring stages as required per each job requisition. We are also allowing you to 
enforce your users to select a job application when hiring; and only job applications with all 
required hiring stages completed will show on the pick list upon hiring an applicant. 

NOTE: Applicant hiring stages will remain as-is at the global level, meaning there is no sort 
order or ability to mark as required. 

Enhancements & Updates 

Hiring Stages Widget Added to Job Requisitions 
The Hiring Stages widget has been added in Job Requisitions. As with the other widgets, a jump link in 
the side panel is available. This is also available for Job Requisition Templates and the same options and 
criteria that apply to Job Requisitions also apply to templates.   

 

• Hiring stages from the global level will appear in this widget.  

– Hiring stages are created under Company Settings > HR Setup > Applicant Tracking/Recruitment > Hiring 
Stages.   
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– Any edits or additions to existing hiring stages at the global level will update only new job requisitions. 
Existing job requisitions will not be updated so all applications tied to a job requisition go through the 
same experience. 

– Any edits or additions to hiring stages at the global level will affect all job requisition templates (except 
sort order). For example, if a hiring stage is renamed, when a user selects the template in creating a job 
requisition, the template will contain the new name. A warning message will display to inform users when 
editing. When adding a new hiring stage to a template, it will display at the bottom of the list and be 
disabled. You can then enable it and move it to the desired sequence.   

– Deletion of hiring stages is not allowed if they are enabled in a job requisition or job requisition template. 
If disabled, deletion is allowed if there are no job applications tied to it.   

 

• In the widget, from the action ellipses of each hiring stage, you can do the following for each hiring stage 
listed:  

– Disable (or Enable)  

– Mark As Required (or Mark as Optional)   

– Move Up/Down  

– Enter a sequence number in the Move To field to quickly move to a new position in the list. 

• For backwards compatibility, all hiring stages for existing job requisitions will be in enabled mode, not marked 
as required, and in existing sequence order as the global hiring stages with enforce sort order disabled.  

 

New Setting to Require Selection of Job Application When Hiring 
147748 & 155180: You can opt to hire only applicants who have gone through all required hiring stages 
for the applicant’s job application. This option is available when using the Hire button from the applicant 
screen or when using an HR Action to hire. 

Recruitment Configuration 

A new Require Selection of Job Application for Hire setting has been added to the Applicant 
Tracking/Recruitment Configuration widget in the Configuration page of the Recruitment module.  

  

When checked, the following can be expected. 

Using Hire Button from Applicant Page 
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• Users will be required to select a job application during the hiring process. 

• In the job applications selection list, only job applications where all required hiring stages have been 
completed will display. 

HR Actions 

For HR Actions, the option is located in HR Action configuration under Company Settings > HR Setup > 
HR Actions and only those applications will appear which have all required hiring stages completed.   

  

Using an HR Action to Hire 

• Users will receive a pop-up requiring them to select a job application during the hiring process.  

• If user hires from the employee page and an HR Action is required for hiring, the system will still prompt for 
the required job application.  

• In the job applications selection list, only job applications where all required hiring stages have been 
completed will display. 

NOTE: Completion of a step is the act of marking it via the darkened circle. If a workflow is attached to 
the hiring stage that triggers upon marking complete, the hiring stage is defined as complete when 
marking complete, not the workflow being completed as well. 

Hiring Stage Timeline Completion Status  
160368: Previously, if users skipped ahead in Hiring Stages, the system would darken the previous hiring 
stages as well, even though in the Hiring Stages Change History widget only the completed stages would 
show. There was a disconnect between what had been completed and what the Hiring Stages widget 
showed.  

Now: When modifying the hiring stages and Enforce Sequence is not enabled, users can skip and 
complete steps without the system showing preceding stages as completed. In the Hiring Stages Change 
History widget, only the completed stages will show. (Completion of a step is the act of marking it 
via the darkened circle. If a workflow is attached to the hiring stage that triggers upon marking 
complete, the hiring stage is defined as complete when marking complete, not the workflow 
being completed as well.)   
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If Enforce Sequence is enabled, the hiring stages will be grayed out and unavailable and users must 
complete each of the stages in sequential order. 

Mass Updating of Hiring Stages 
149021: When users attempt to mass update job application hiring stages, an error message will appear 
when the job applications selected for the hiring stage update are not for the same job requisition. The 
error reads: All of the job applications selected for hiring stage update must be for the same job 
requisition. 

Identified areas: 

• Job Applications Report (Team > Recruitment  > Candidates > Job Application) 

• Recruitment Questionnaire Answers Report (Team > Recruitment > Candidates > Recruitment Questionnaire 
Answers Report) 

• Applicants Job Applications (Team > Recruitment > Candidates > Applicants > View Applicant > Job 
Applications)  

New UI: Recruitment – Job Requisition Templates 

Creating Job Requisition Templates Using Existing Requisition 
145250: Creating new job requisition templates will now be easier. Users will now be able to select an 
existing job requisition and use it to create a new template.  

In the Job Requisition field in the Template Details widget, users can use the lookup to select an existing 
requisition. And Info icon explains that data can be copied from existing job requisitions into the 
template. 

A warning message displays to inform the user that all fields will be overridden with the selection. Once 
proceeding, the data in the fields shall be prepopulated from the selected job requisition and if 
the prepopulated Job(HR) is active then the job specific fields (Job Title, Employee Type, Job 
Description & Job Categories) are pre-populated from the job instead. Once saved, the template is 
ready for use when creating new job requisitions under Team > Recruitment > Job Requisitions.  
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Job Requisition Template Use Once Assigned to Job Application 
153309: The Job Requisition Template field will be grayed out once a job requisition is used in job 
applications. This will prevent users from selecting new templates in the job requisitions and preserve 
the intended settings from the original template.   

 

New UI: Recruitment Questionnaires 

Message When Assigning Questionnaires to Group for Users with Limited Authority 
153364: For users with limited access to the employees of a company group, a pop-up message 
will display to the user when assigning a recruitment questionnaire when selecting a group 
where the user does not have access to all of the employees in that group. The message will 
show the number of employees processed and why they were skipped. It will also show in the 
message if employees were skipped due to having a terminated status or the questionnaire was 
previously added to the selected employees. If the user has access to no employees, the 
message will inform the user no employees were updated due to their permissions.   

A View Skipped Selections link will be available so users can view the affected employees they have 
permission to see.  

  

To Do Item Generated When Assigning Recruitment Evaluation Questionnaire 
153585: When assigning a Recruitment Evaluation Questionnaire to complete, a notification can be 
configured to let the assignee know a questionnaire has been assigned for them to complete. Previously, 
it was required that these users had to find the Job Application page, then find the application in the 
report page and click to open the questionnaire. 

In this release we are adding functionality that will generate a To Do Item for the recipient when a 
questionnaire is assigned to them. In the To Do Item there will be a direct link to the questionnaire 
(Start button), and if the user has permission, a link to View Resume and View Job Requisition may also 
be present.  

The To Do Item will stay in their list until it has been completed. 
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New UI: Recruitment Quick Apply 

Questionnaires Allowed on Job Requisitions for Quick Apply 
147618: You can now attach an applicant questionnaire to job requisitions set to allow Quick Apply. 
When Quick Apply has a questionnaire attached, the applicant will click the Continue button on the 
Quick Apply popup, which will then open the questionnaire to be completed.  Applicants will complete 
the questionnaire and click the Save & Apply button.  

Resume Required Checkbox Added for Quick Apply 
145624: A Resume Required checkbox has been added to the Requisition Details widget in the Job 
Requisition configuration page. This checkbox can be used when also checking Allow Quick Apply.  

 

• When the checkbox is checked, the applicant must upload a resume when applying for that job. 

• When the checkbox is NOT checked, the applicant still has the option to upload resume, but it is not required. 
The applicant can move forward without uploading a resume. 

Multiple Resumes Allowed for Quick Apply Applicants 
146748, 154618, 154624, 153998, 154002, 158631, 154619 

Applicants using Quick Apply can now upload more than one resume when applying for multiple jobs. 
They can now have one resume per job applied for. All resumes uploaded through the job 
applications will be visible in the Applicant Documents widget. 

• The resume will be associated with the Applicant Profile and at the Job Application level.   

• Hiring managers will be able to view the resume specific to the job application on the Job Applications report 
page (using the View Text Resume icon) and can also be viewed inside the job application in the Resume 
widget. They will also be able to edit and change the resume on this page on completed job applications. If 
the resume is switched out, the new resume will be the resume of record.  

• Quick Apply applicants will be restricted from reapplying for the same job requisition. If attempted, a 
message will be displayed informing the applicant they have already applied to the given job requisition. If 
the original apply process is incomplete, the applicant can proceed with another attempt.   
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NOTE: If Data Retention is enabled in your company, candidates will be presented a consent pop-up for 
the handling of their personal data in our system. Returning candidates who have already given consent 
will not be shown the pop-up again. Returning candidates who have not previously given their consent 
will be presented with the pop-up. 

Email Notification for Quick Apply Applicants 
154000 & 149758: A new notification for Quick Apply applicants has been added to the system. When 
applicants apply for a job through Quick Apply an automatic email will be sent to the applicant to 
instruct them how to access the Applicant Portal and finish the set up their profile. 

• Applicants will be prompted to reset their password via link in email. After resetting, they are taken to their 
applicant profile. 

• If link has expired, an option to send a new link will be available. There is no limit to the number of times a 
new link can be requested.     

New UI: Recruitment Traditional Applicants 

Multiple Resumes Allowed for Traditional Applicants 
157516, 146756, 157505: Applicants using the Applicant Portal can now upload multiple resumes with 
one resume allowed per each job application.  

• When a resume is uploaded for a specific job application, that resume will be stored at the job application 
level. 

• The most recent resume uploaded for that individual applicant will also update the resume on the applicant 
record. 

• Recruiter/Hiring Manager will be able to view the resume specific to the job application on the Job 
Application report with the View Resume icon & also inside the Job Application. 

Example: User applies to Job Req A and uploads Resume A.  Resume A will be viewable on Job 
Application A and the applicant record. 

Same user then applies to Job Req B and uploads Resume B. Resume B will be viewable on Job 
Application B and the applicant record. Resume A is still the only resume viewable on Job Application A. 

Resume Required Checkbox Added for Traditional Applicants 
161237: A Resume Required checkbox has been added to the Requisition Details widget in the Job 
Requisition configuration page.   

 

• When the checkbox is checked, the applicant must upload a resume when applying for that job. 

• When the checkbox is NOT checked, the applicant still has the option to upload resume, but it is not required. 
The applicant can move forward without uploading a resume. 
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New UI: Recruitment Workflows 

Recruitment: Applicant Custom Form Workflow Routing to Correct Manager 
146144 & 163716: When an Applicant Custom Form workflow has been assigned to an applicant, and 
there are multiple job applications assigned to the applicant, the workflow will now route to the correct 
manager. Previously in this scenario, the backup manager received the To Do items instead of the 
correct hiring manager.  

 
New UI: Reports 

Pay Statement History (Imported): Calendar Range Added to Pay Date Options 
137652: In the Pay Statement History (Imported) report, Calendar Range has been added to the list of 
options under the Pay Date filter. When selected, a calendar range can be defined for the report.  

The report is located under Team > Payroll > Reports > Pay History and the company must have Import 
External Pay History enabled in the Available Functionality widget of their company. The purpose for this 
functionality is to export external pay statements from another system into our system for reporting 
purposes only.   

 

 

Open Enrollment Report: Employee Filter Logic Update 
152441: In the Admin Open Enrollment report (Reports > HR Reports > Open Enrollment), the 
logic for the “# Employees” columns have been updated to better reflect the number of 
employees who may participate in Open Enrollment. Employees with Terminated status are 
filtered out to make the employee counts more meaningful. 
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Time and Labor 
Added Date Field to Employee/Manager Signature on Printed Timesheets (Classic UI & 
New UI)  
148166: For companies that require employees to sign and date their timesheets, Manager Signature 
Line and Employee Signature Line options have been added to the timesheet Print Settings. To access 
Print Settings, navigate to Team > Time > Timesheets > Manage Timesheets > All Timesheets, select the 
employee’s timesheet, then select the three-dot ellipse and click Print. When one or both options are 
enabled, the signature line and date line will display on the printed timesheet. 

NOTE: Timesheets can also be printed directly from the timesheet in the Classic UI. 

Added Time Off Type Selector & Day Selector to Calculate Dynamic Duration Rule (Classic 
UI & New UI)  
139489: To accommodate companies that calculate time off hours and types differently, two new 
sections have been added to the Calculate Time Off Dynamic Duration rule: 

• Only Apply On Following Time Offs – A List Time Off Entries selector is available in this section to allow you 
to choose a specific type of time off.  

• Only Apply On Following Days – Select which days of the week the chosen time off type will apply to.  

  
 
NOTE: There is now support for multiple dynamic duration rules to be active in one pay calc profile.  

Added Working Time Regulations to Company Setup > Defaults Tab (Classic UI & New UI)  
87034: A new field, Working Time Regulations, has been added to the Profiles section under the 
Defaults tab of Company Setup. Previously, users had to manually add this field for new employees.  

Attestation – Workflow – Punch Summary / Punch Date Tags (Classic UI & New UI)  
154384: You can now add Punch_Summary and Punch_Date tags to an attestation notification from the 
Generate Notification step of the Attestation Questionnaire workflow so that the user receiving the 
notification can easily access the punch summary for that date. Previously, attestation notifications did 
not include punch summary and date information. 

Disable Biometrics on InTouch from Terminal Settings (Classic UI & New UI)  
160997: To assist in preventing the spread of illnesses, users can now disable biometrics remotely from 
the Terminal Configuration for all versions of InTouch clocks.  
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What has been added: A new checkbox, Biometrics, has been added to the Terminal Configuration for 
InTouch clocks. If Biometrics is not enabled, the biometric reader on the clock will be disabled. 
Additionally, all biometric-related features will be disabled as well. Enroll/Unenroll soft keys will not be 
displayed on the InTouch clock and all Verify Finger options will be removed from all SmartView soft 
keys.   

Employee Information – Points – Removed “Edit” Capabilities from ESS “View Detailed 
Points History” (Classic UI & New UI)  
151725: Employees will not have editing capabilities from the Detailed Points History report unless View 
Detailed Points History and Edit Balances is enabled in the security profile. The edit pencil icon will 
display and can be selected on the Detailed Points History report whether the user has editing 
permissions or not. If the user does not have editing permissions, they will not be able to edit point 
details. If the view permission is set in their security profile, users can view any manually edited points. 

 
Reports – “Exception Entries” Audit Trail Report (Classic UI & New UI) 
126299: A new Audit Trail report, Exception Entries is now available to display information about 
employees who have had time exceptions (such as fixing missed punches or edits to From and To times) 
made to their records or had those exceptions cleared. This report is available in the following locations 
in the New UI: 

• MSS: Time > Reports > Audit Trail > Exception Entries 

• ESS: My Reports > Time Reports > Audit Trail > Exception Entries 

In the Classic UI, it is available at My Reports > System > Audit Trail > TA > Exception Entries. 

Report Dialogs  

Report Dialogs – Initiate Notification on Timesheet Submit (Classic UI & New UI)  
159369: A new notification for Report Dialogs has been added, Time Entries Require Manager Approval 
On Submit. Previously, other Report Dialogs notifications had to be scheduled to run via the When 
widget, which triggered a one-time notification. Because of this, users would not receive a notification 
for each new timesheet submission, and instead had to find the email containing the original report 
dialogs link to approve the time entry.  

What is different from other Report Dialogs Notifications:  

• Cost Center Managers are currently the only recipients who can receive this notification. In a future release, 
all recipients in the existing Report Dialogs notifications will be included.  

• The When widget has been removed for this notification because the notification will be sent to the Cost 
Center Manager each time a timesheet is submitted.    

 
Timesheet Utilities – Renamed “Timesheet Changes” to “Timesheet Audit Trail” (Classic 
UI & New UI)  
160169: Under the timesheet Utilities, the option Timesheet Changes has been renamed to Timesheet 
Audit Trail.  

Time Off – All Open – View Time Off Counts Button [MSS] (Classic UI & New UI)  
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151938: Button: View Time Off Counts column is now available to add to the All Open page under Team 
> Time > Time Off > All Open. When the View Time Off Counts button is added, managers will be able to 
view an employee’s accrual balances from the Time Off Counts pop-up window.  

 

 

TOR – Calculate Projected Balances During Request 

Time Off Requests – Modify Request & Submit Request (Classic UI & New UI) 
151767 & 139358: Currently, employees can only view their projected accrual balance for the entire 
accrual year when requesting time off and inside their employee profile accruals widget. The system can 
validate against projected balances and trigger errors/warnings if the employee won’t have enough 
hours to cover the request, but employees cannot see this calculated value before submitting the 
request or in instances where an error/warning wouldn’t be triggered. Employees will now have a way 
to see their projected start and end balances when submitting or modifying a time off request. 

What has been added: A Calculate button for Projected Balances has been added to the following:  

• Modify Time Off Request screen 

• Request Time Off pop-up window 

 
When the Calculate button is selected, the projected starting and ending balances will be displayed. 
Projected balances will be calculated based off the Excess Settings configuration in the employee’s time 
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off request profile.  If Excess Settings is disabled or the employee does not have a time off request 
profile assigned, it will project based on the end of the accrual year by default.  

 

 

Time Off Requests – Available Accrual Balance on Date of Request Access Permissions (Classic UI & New 
UI) 
158774: Calculate and Projected Balances will be hidden in the following scenarios: 

• When a user selects a time off category that is attached to an accrual policy with the Display Projected 
setting (in the Accrual rules) disabled.   

• When a user selects a time off category that is not attached to an accrual policy at all.   

– The scenarios above apply to both submit request (ESS) and modify request (MSS) pop-ups. 

• The employee doesn't have the ability to view their own accrual balances in their security profile.  

– This applies to submit request (ESS) pop-ups only. 

• The manager doesn't have the ability to view their employee's accrual balances in their security profile. 

– This applies to both submit request on behalf of employee (MSS) and modify request (MSS) pop-ups. 

• When the employee does not have an Accruals profile assigned to them. 

– This applies to both submit request (ESS) and modify request (MSS) pop-ups. 

 
Time Off Request Notifications for Cancelled Requests (Classic UI & New UI)  
136504: Users will now receive a Time Off Canceled notification when an approved time off request is 
deleted.  
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New UI Updates – Table of Functionality Added to Pages 
The table below shows the updates made within the New UI and the functionality added.   

Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

110324 
(EPIC) 

TLM Points MSS: Time > Points 
> Balances 

Edit and view 
points changes 
icon available.  

No Yes 
 

110324 
 (EPIC) 

TLM Points MSS: Time > Points 
> Balances 

Change Updated 
To Date button 

available.  

Yes Yes 

110324 
(Epic) 

TLM Points MSS: Time > Points 
> Balances 

Run Points Rules 
button available. 

Yes Yes 

110324 
(Epic) 

TLM Points Time > Reports > 
Points > Points 
History Report  

User can add 
points to the 

Employee Points 
reports. 

Yes Yes 

110324 
(Epic) 

TLM Points MSS: Time > Points 
> Balances 

Edit Points 
balances and 
view changes. 

Yes Yes 
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Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

111801 
(Epic) 

TLM Reports Time > Timesheets > 
Change Requests > 

All Timesheet 
Change Requests 

Added Button: 
Open Timesheet 

column to 
Timesheet 

Change Request 
report. 

Yes Yes 

141897 
(Epic) 

TLM  Workflow Time > Overtime > 
Request 

Overtime 
Request screen 

available.  

Yes Yes 

111801 
(Epic) 

TLM Reports Time > Timesheets > 
Change Requests > 

All Timesheet 
Change Requests 

Added Button: 
Open Timesheet 
to the Pending 

Timesheet 
Change Request 

report. 

Yes Yes 

141897 
(Epic) 

TLM Reports My Time > Overtime 
> Overtime Requests 

- Awaiting 
Acceptance  

Awaiting 
Acceptance 
report for 
overtime 
requests 
available.  

Yes Yes 

110324 
(Epic) 

TLM Points MSS: My Team > 
Employee 

Information 
ESS: My Information 

> My Profile > My 
Profile 

Manage Points 
link will display 
in Points widget 

under the 
Employee 

Profile. 

Yes Yes 

110324 
(Epic) 

TLM Points My Reports > Time 
Reports > Points 

Edit, view, and 
run points rules 
on Employees’ 
Points History 

Report.  

Yes Yes 

150861 TLM Points Time > Timesheets > 
Approve Extra Pay 

Entries 

Approve extra 
pay entries from 
the Approve Extra 

Pay Entries 
report. 

Yes Yes 
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Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

154543 
147922 
154542 
156119 

TLM Accruals Accruals > Run 
Accruals 

Execute Accruals 
Rules under Run 

Accruals is 
available.  

Yes Yes 

148383 
(Epic) 

TLM Leave of 
Absence  

MSS: Leave > 
Balances 

Run entitlement 
and balance 

rules from the 
Entitlement and 
Balances report. 

Yes Yes 

148383 
(Epic) 

TLM Leave of 
Absence  

My Time > Leave > 
History 

Employees can 
view the details 

of their leave 
requests, and 
managers can 

view these 
details. 

Yes  Yes 

148383 
(Epic) 

TLM Leave of 
Absence 

MSS/ESS: Leave > 
Cases 

Ability to add a 
note to the 

Leave of 
Absence 
Request. 

Yes Yes 

148383 
(Epic) 

TLM Leave of 
Absence 

MSS: Leave > 
History 

Managers and 
admins can view 
the details of a 
leave request.  

Yes Yes 

148383 
(Epic) 

TLM Leave of 
Absence 

ESS: Leave > 
Request 

All actions in the 
employee’s 

Leave of 
Absence 

Request page 
are available.  

Yes Yes 

148383 
(Epic) 

TLM Leave of 
Absence 

ESS: Leave > 
Request 

Employees can 
view recent 

requests from 
the Leave of 

Absence 
Request page.  

Yes Yes 
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Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

148383 
(Epic) 

TLM Leave of 
Absence  

ESS: My Time > 
Leave > Request 

Intermittent 
(Weekdays) is 
available as a 

leave of absence 
request type 

along with Use 
Separate 
Settings 

checkbox. 

Yes Yes 

156121 TLM Accruals Accruals > Details The Accruals 
History report is 
available from 
Details via the 

Menu.  

Yes  Yes 

151982 TLM Timesheets MSS: Time > 
Timesheets > 

Early/Late Punch 
Override 

Users can give 
employees 

additional time 
to register a 

punch. 

Yes Yes 

158134 TLM Timesheets MSS: Time > 
Timesheets > 

Early/Late Punch 
Override 

Users can give 
employees 

additional time 
to register a 

punch from the 
Employee 

Information 
page. 

Yes Yes 

141897 
(Epic) 

TLM Overtime Time > Overtime > 
Request 

The Change 
History report 

on the Overtime 
Request screen 

is a non-editable 
table. 

Yes Yes 

141897 
(Epic) 

TLM Overtime Time > Overtime > 
Request 

The Recent 
Requests report 
on the Overtime 
Request screen 

is a non-editable 
table. 

Yes Yes 
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Ticket or (EPIC) Product Component New UI Menu Path Functionality 
Added 

Desk-
top 

Mobile 

160573 
(Epic) 

TLM Overtime Time > Overtime > 
Request 

The Overtime 
Request screen 

is available.  

Yes Yes 

160573 
(Epic) 

TLM Overtime Time > Overtime > 
Request 

Managers can 
create and 
Overtime 

Request on 
behalf of the 

employee. 

Yes Yes 

 
New UI: Added Approval State as Default Column – MSS Timesheets Report (Desktop & 
Mobile) 
160083: In order to allow managers to be able to easily view the approval state of the timesheet, a new 
default column, Approval State, has been added to the Timesheets report.  

New UI: Disabled Checkbox in Weekly Report (Desktop & Mobile) 
133808: In the Weekly Schedule report (Team > Schedule > Team Schedule View > 
Weekly/Daily Schedule > Weekly Schedule), if an employee has an assigned Scheduler Profile, 
the selection checkbox for the row with the employee’s information is disabled (not hidden).  

 

New UI: Timesheets Approval History – Created New Mobile App Report [MSS] (Desktop 
& Mobile) 
151968, 151981: As previously seen in the New Desktop Experience, the Timesheets Approval History 
report is now available in the New Mobile App under Time > Timesheets > Timesheets Approval History. 
To view the Approval History from the Timesheets Approval History report, select the Timesheet 
Approval icon.  

New UI: Time Entry Approval State in Report/To-Dos 

Added Time Entry Approval Record Column to To Do Item Report (Desktop & Mobile) 
138844: In My To Do Items, the Approve Time Entries report has been updated to include an Approval 
State column so that users can easily see each time entry's approval status. 
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New UI: Time Off – All Open – Review/Modify Time Off Button [MSS] (Desktop & Mobile) 
151949: In the time off All Open report, a new column has been added with a Review/Modify Time Off 
icon. This column will display by default. When the icon is selected, a Modify Time Off Request pop-up 
window will display.  

New UI: Time Off – All Open & Pending Approval – Date Requested (View Scheduled 
People) Hyperlink [MSS] (Desktop & Mobile) 
151954: Date hyperlinks will display in the Date Requested column on the All Open and Pending 
Approval pages. The View Scheduled People pop-up window will display upon clicking the date 
hyperlink.  

New UI: Time Off – All Open – Reject and Approve Buttons [MSS] (Desktop & Mobile) 
151951, 151950, 151960: The Reject and Approve buttons are available when multiselecting pending 
time offs from the All Open report.  

 

New UI: Time Off – Pending Approval Report Added to All Open Report (Desktop & 
Mobile) 
151929: The Pending Approval report is now available as a view in the All Open report, under Team > 
Time > Time Off > All Open.  

New UI: Time Off – Pending Approval – Reject Page Level Button [MSS] (Desktop & 
Mobile) 
151959: The Reject button is available next to the Approve button when multiselecting pending time 
offs from the Pending Approval report.  

New UI: Time Off – Pending Approval – Review/Modify Time Off Button (Desktop & 
Mobile) 
151961:  In the time off Pending Approval report, a new column has been added with a Review/Modify 
Time Off icon. This column will display by default. When the icon is selected, a Modify Time Off Request 
pop-up window will display. 

New UI: Timesheet – Print Utility – Added Total Rate Table Amount Columns (Desktop & 
Mobile) 
140319, 152350: Previously, when printing timesheets, the print preview displayed the rate tied to the 
hours, but the total rate table amount that was calculated would not display. Total Rate Table Amount 
fields are now available to be enabled under Print Timesheet.  

 

If the Rate Table X Rate fields are enabled, a new setting, Rates, will display in the Time Summary 
Totals section of the print preview. This will allow for the rate and calculated amount to display.  
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When these settings are enabled, the Total Rate Table X Amount column in the print preview will 
display next to the Rate Table X Rate if that column is also enabled. In addition, the Cost Center will 
display. 
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Payroll 
Bank Accounts (Classic UI & New UI) 

Originating Banks: Company EIN in Company Discretionary Data Field (Classic UI & New UI) 
151072: Users can now choose the Company (Employer) EIN for the Company Discretionary data field in 
the ACH Batch Header section of the Originating Banks (Maintenance > Configuration > Originating 
Banks in Admin companies and Company Settings > Payroll Setup > Originating Banks in Client 
companies). 

 

When Company EIN is selected for the Company Discretionary data field, the correct information 
displays in the correct format within the ACH file. The Company EIN (Tax ID) is pulled from the Tax ID 
field under Company Settings > Global Setup > Company EINs.  

The Company EIN is listed in positions 21-40 in the Record Type Code 5 record and displays as left 
justified with no dash.  

Earning Codes (Classic UI & New UI) 

Country Code for Earning Codes (Classic UI & New UI) 
151066: When a user adds an Earning Code from within a company under Company Settings > Payroll 
Setup > Earnings Codes, only the Earning Types (Roll up Earning) that are applicable for the countries 
the company is set up for are available. 

When a company or the Admin Company is configured for both the US and Canada, a Country can be 
selected for the Earning Code so that only the Earning Codes for that country can be selected.  

 

NOTE: An Earning Type can be associated with either Canada or the US, but not both. 
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Forms (Classic UI & New UI) 

2020 State W-4 Withholding Forms (Classic UI & New UI) 
The following states have released their state specific withholding forms for 2020, and the forms are 
now available within the system. 

Ticket number State Form 
147667 Iowa W-4 
147759 Arizona W-4 
147764 Connecticut W-4 
147789 Michigan MI W-4 
147791 Minnesota W-4 MN 
148174 Missouri MO W-4 
148498 New Jersey W-4 
148725 New York IT-2104 
148728 Rhode Island W-4 
148780 New York IT-2104-E 
149735 Illinois W-4 
152038 Delaware W-4 
152065 Maryland MW507 
153192 Arkansas AR4EC 
155850 Massachusetts M-4 
155853 New York IT-2104 
155858 Missouri MO W-4 
155861 New Jersey W-4 
155864 Indiana WH-4 
155869 Wisconsin W-4 
148824 Vermont W-4VT 
153388 California DE4 
94029, 165140 Puerto Rico Tax Withholding Form 499-R-

4, Add 2020 Form 499-R-4 
from drop-down menu 

 

Retirement Plans (Classic UI & New UI) 

Safe Harbor Annual Compensation Limit Calculation Percentage (Classic UI & New UI) 
105960: When users add or edit an existing Retirement Plan profile, they can now input/edit the 
percentage for the Safe Harbor Annual Compensation Limit, which follows the Enhanced employer 
contribution. The employer amount will be reduced according to the appointed percentage for the Safe 
Harbor Annual Compensation Limit. Users can not add a percent that exceeds the maximum allowable 
contribution percent, currently 6%.  

There are 3 different ways that employer contributions can be allocated for Safe Harbor plans. The 3 
contribution methods are: 
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• Basic – The employer matches 100% of the first 3% of compensation, plus 50% of the next 2%.  
• Enhanced – A formula must be at least as generous as the basic match and cannot be more than 6% of 

compensation.  A common enhanced match is 100% of the first 4% of compensation.  
• Non-Elective – The employer contributes 3% of compensation to all eligible employees.   

 

 

Reports (Classic UI & New UI) 

State Reciprocity Override as a Column in Reports (Classic UI & New UI) 
146403: From Available Columns, Admins can now add a State Reciprocity Override and an 
Unemployment State column to the following reports: 

• All System Accounts (Maintenance > All System Accounts) 
• All Tax Accounts (Maintenance > Client Resources > Payroll (Taxes) > Account Taxes) 

Also, from Available Columns, Clients can now add a State Reciprocity Override to the following reports: 

• Employee Information (Team > My Team > Employee Information) 
• Account Taxes (Team > Payroll > Employee Payroll Maintenance > Taxes > Taxes) 

 

Tax Information (Classic UI & New UI) 

Tool Tip for State Reciprocity Override Settings (Classic UI & New UI) 
155684: The system now includes a tooltip next to the State Reciprocity Override field (Employee 
Information > Payroll Tab > Tax Information > State) to help users understand the various selections 
available for the field. 
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Employee Setup: My Paycheck Simulator did not Reflect 2020 Federal W-4 Fields 
152666: Employees can now see the 2020 Federal W-4 fields on the My Paycheck Simulator page when 
they click the Paycheck Simulator button. Previously, employees could not see their 2020 W-4 
information on this page. 

Garnishments: Garnishment Deduction Required Save to Calculate 
134166: In the Deduction Wizard, when users configure a garnishment deduction to calculate as a 
percentage of disposable earnings and then create a pay statement, the garnishment now displays on 
the pay statement. Previously, if users did not save the deduction before creating the pay statement, 
the pay statement would not display the garnishment. 

General: Retirement Plan Eligibility Date for Hire Dates on the 1st 
89722: If an employee starts on the first day of a month, the system now correctly calculates the 
employee's eligibility date for retirement plans. Previously, when employees started on the first day of 
some months, the system incorrectly calculated their eligibility date. 
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Scheduler 
Added Column to Open Shifts to Display Posted Status and List of Employees Open Shift 
Has Been Posted to (Classic UI & New UI) 
155124, 155125: Two new columns, Posted and Posted To, have been added to the Open Shifts report 
(Schedule > Staffing > Open Shifts). The Posted column will indicate if the shift has been posted or not 
and the Posted To column will display which employees the shift was posted to. 

 

Added Day Type Column to Summary by Employee and Open Shifts Reports (Classic UI & 
New UI) 
152457: If Day Type is enabled from Company Settings in the TLM Policies widget (Company Settings > 
Global Setup > Company Setup > Company Config), you will be able to add the Day Type column to the 
Summary By Employee and Open Shifts reports. This will allow users to report on day type if they are 
assigned to shifts.  

 

 

Added Day Type to Schedule Shifts Import and Schedule Template Imports (Classic UI & 
New UI) 
152456: A Day Type column is now available via the Schedule Shifts and Schedule Template imports so 
that a Day Type can be automatically assigned to a shift.   
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Added Start Date to Schedule Template Auto-Generate Parameters (Classic UI & New UI) 
158780: Previously, you could not choose a start date for when a schedule would auto-generate. Going 
forward, you can now select a specific start date for when schedules should begin auto-generating.  

What has been added: From the Automatically Generate Schedule From Template widget under the 
Schedule Template page, a new field is available, Starting On, which provides a calendar date selector. If 
you enter a number in the Auto Generate _ Days Before Start Date field, that will pertain to the days 
before the start date chosen when the schedule will begin auto-generating.  
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Availability/Preferences Select All Could Not Load More Than Certain Amount of 
Employees (Classic UI & New UI) 
148819: Previously, the system would not load a certain number of employees from the 
Availability/Preferences screen.  

What is new:  

• The first 50 employees will be listed when you click the Existing Availability/Preferences button, with the 
option to load more employees. 

• Availabilities/preferences will display for any selected number of employees when you click the Existing 
Availability/Preferences button.  

• If one employee is selected, their availability/preferences will display on the calendar. If multiple employees 
are selected, data will not display on the calendar.  

• From the Existing Availability/Preferences pop-up window, you will be able to delete by selecting Delete 
All Availability and Delete All Preferences.  

Created ESS Rejection Notification (Classic UI & New UI) 
150183: Previously, when multiple employees requested the same open shift, or when multiple 
employees were selected for shift swaps and coverage requests, the employees who were approved 
received a notification but the employees who were rejected did not receive a notification.  

What has been added: In the default workflow within the Generate Notification step, a new option, Non 
Approved Peers has been added to the Send Notification To drop-down so that a notification is sent to 
employees who have been rejected.  

NOTE: Existing workflows will need to have this step added manually.  

Previous Day Start  

Added Previous Day Details to Shift Notification (Classic UI & New UI) 
156175: Previous day details will now be included when applicable in global notifications for schedule 
changes/posting of schedules, posted open shifts, and schedule peer action so that employees are 
informed that the shift will start on the previous day of when the shift was assigned.   

 

Added “Start Date” Option to Manage Shift Window (Classic UI & New UI) 
147955: A Start Date field has been added to the Manage Shift window for reports and in all schedule 
views so that you can select a previous start date. For example, if the shift starts on 11 PM (Friday night) 
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to 7 AM (Saturday morning), with this new feature, the shift will be applied to Saturday on the 
timesheet even though the shift begins on Friday. 

 

 

Added “Start Date” Option to Workload Template and Import (Classic UI & New UI) 
154242: A Start Date column is now available when creating new shifts, including via Workload Template 
and workload template import files, so that you can assign a previous day start to shifts. When a 
previous day is selected, this assignment will appear on the scheduled shifts.  

 

Added Start Day to Schedule Shifts and Template Shifts Import Files (Classic UI & New UI) 
154526: In order to allow for a previous start date to be determined, a Start Date column has been 
added to the Schedule and Shifts template imports.  

Roll Call Report Match Criteria on Scheduled Employee (Classic UI & New UI) 
159380: A new match criteria option, Absolute Employee Match, is available for the Roll Call report from 
the Global tab under Filters. When enabled, the system will match a clocked in employee to their 
scheduled shift regardless of their shift cost center.  

If an employee is scheduled for multiple shifts per day, the first clock in will match the first scheduled 
shift, the second clock in will match the second scheduled shift, etc.  

If a scheduled employee does not clock in, the shift will display as open with no match.   
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Schedule Fairness Spread of Hours Rule (Classic UI & New UI) 
141649: A new rule, Spread of Hours, has been added to Schedule Fairness. This rule allows for extra 
pay when an employee’s spread of hours between the start time of the first shift of the day and end 
time of the last shift of the day exceeds X number of hours. This interval of time includes scheduled time 
plus lunch/breaks. The spread of hours also applies to an employee working more than one shift in a 
day, and one of the shifts exceeds 10 hours. 

To-Do Items were Not Removed from Employee To-Do List After Expiration (Classic UI & 
New UI) 
153564: Previously, if To-Do items such as Shift Swap and Coverage requests were not manually 
rejected, the requests remained in the My To Do Items list despite the dates being expired. Going 
forward, To-Do items will be automatically removed from the list when the associated date has expired. 

New UI: Added Owner and Date Created Field to Schedule Manage Views Pop-Up 
(Desktop & Mobile) 
152386: Owner and Date Created columns have been added to the Manage Views pop-up window on 
the schedule so that you can see who created the view settings and the date that they were created.  

 

New UI: Added Start Time in Sort Option in Day View (Desktop & Mobile) 
152398: A new sort option in the Day View has been added, Shift Start Time. When selected, the 
schedule will be chronologically ordered by the earliest shifts to the latest, along with the option to sort 
ascending or descending.    
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New UI: Added Toggle to Show Scheduled Employees Only to Schedule and Schedule 
Templates (Desktop & Mobile) 
152402: A new toggle, Scheduled Employees Only, has been added to the schedule views and schedule 
templates so that only employees who have scheduled shifts assigned will display. If you print or save 
the view of the schedule with the toggle enabled, the settings will remain.  

 

New UI: Added View By Week/View By Month to the Drop-Down List on Schedule by 
Employee Report (Desktop) 
157682: In a previous release, View By Day was added to the drop-down from the three-dot ellipsis 
button for the following reports/screens: 

• Schedule By Employee report 

• Individual schedule settings 

• View By Employee screen 

• View By Cost Center screen 

• Schedule Table View 

What has been added: View By Week and View By Month have been added to these reports/screens.  
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New UI: Allow User to Determine Paste Location of Copied Shifts – Day/Week/Month 
Views (Desktop & Mobile) 
155127,155126: Previously, when a single shift or multiple shifts were selected and copied in any of the 
views, they could be pasted only to the same employee and day that they were copied from.  

What’s new: When you copy a single shift or multiple shifts, you can now select any employee row, as 
well as the Open Shifts panel in the day, week or month view to paste the shift(s) to. 

New UI: Disabled Checkbox in Weekly Report (Desktop & Mobile) 
133808: In the Weekly Schedule report (Team > Schedule > Team Schedule View > 
Weekly/Daily Schedule > Weekly Schedule), if an employee has an assigned Scheduler Profile, 
the selection checkbox for the row with the employee’s information is disabled (not hidden).  

 

New UI: Display Employee’s Nickname in To-Dos and Schedule Views (Desktop & Mobile) 
159987,159986: Previously, To-Do items and schedule views only displayed the employee’s legal first 
and last name.  

What’s new: The option for having the employee’s nickname (along with their last name) display on the 
schedule for any of the schedule views, as well as the To-Do items, is now available.  

First confirm that the employee’s nickname is entered in the employee’s profile, then within the 
Employee Information widget on the Schedule Profile, enable Use Employee Nickname.  

NOTE: The employee’s first name will be used if the nickname is configured, but not defined for the 
employee.  

New UI: Enabled Floating Cost Centers Override Constraints List to Remove Non-Floating 
Employees (Desktop & Mobile) 
152459: Previously, when Floating Cost Centers was selected for Constraint Group from the Override 
Constraints window, a list of all employees who were already on the schedule would display.  

What has been added: A new checkbox has been added to Enable Floating Cost Centers. When 
enabled, only the floating employees available (as opposed to all employees) will display on the 
schedule so that you can determine if you have extra resources. 
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New UI: Link to Schedule Setting from Schedule Views (Desktop) 
160007: A link has been added at the top of the page for all schedule views so that you can navigate 
back to the individual Schedule settings when you click the link.   

 

New UI: List Daily Rules in Alphabetical/Numerical Order (Desktop & Mobile) 
155118: For Basic Scheduler users, the daily rules will now be listed in alphabetical/numerical order for 
the following: 

• Daily Schedule  

• Weekly Schedule (Edit/Add Shift) 

• List/Edit Schedule Entries 

• Schedules widget 

New UI: Schedule Overview Default Sort by Start Time of Shift (Desktop & Mobile) 
155123: On the Schedule Overview screen, scheduled shifts will by default be sorted in order from the 
earliest start time to the latest.  

Schedule Settings: Estimated Cost Did Not Calculate for Allocate Regular Hours V2 Rule 
163063: For Pay Calc 2 companies, when a Pay Calc includes the Allocate Regular Hours V2 rule, users 
who select to estimate labor costs on a schedule see correct Estimated Cost calculations in the Pay 
Estimation window. Previously, the Pay Estimation window's Estimated Cost column displayed zeros. 

 


